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Abstract

Tissue regenerates resulting from the healing of transected peripheral nerve differ in
morphological and electrophysiological properties based on the biomaterial implant used to
bridge the interneural wound gap. At gap lengths >10 mm, impermeable silicone tubes promote
little to no nerve regenerate unlike its porous, degradable collagen alternative. This study
assayed rat sciatic nerve wounds treated with silicone and collagen tubes at a 14-day time point
for concentration differences in transforming growth factor beta 1, 2, 3 (TGF 1, P2, and P3) and
alpha smooth muscle actin (a SMA) to measure disparities in proteins associated with wound
healing that may determine nonregenerative from regenerative outcomes.

Transected nerves treated with silicone or collagen tubes were compared on a "whole
wound" basis to determine differences in protein expression over the entire tissue and on a "per
segment" basis to determine local differences in protein expression over -2-4 mm regions of
tissue. Immunofluorescent comparisons of wounds were performed on cross sections taken
along the length of the nerve. In each cross section, a region of interest (ROI) was defined from
the periphery of the regenerate tissue to -65 gm radially inwards where presence of a contractile
capsule was reported by earlier investigators and also observed in this study.

A 200% increase in whole wound TGF P3 levels in the collagen compared to the silicone
treatment group was determined by immunoblot (p=0.0026). A 30-50% increase in whole
wound TGF i1 levels was found in the silicone compared to the collagen treatment group, which
was statistically significant by only one of the two assays used (enzyme-linked immunosorbent
assay; p=0.0021). There was no significant difference in TGF P2 levels between treatment
groups. Whole wound expression of a SMA was 440% greater in the silicone treatment group
than in the collagen treatment group by immunoblot measurement. Immunofluorescent
measurement indicated that a SMA expression in the ROI was 160% greater in silicone than in
collagen treated wounds, with significant differences in the nerve stumps (proximal, p=.0243;
distal, p=.0021).

Proteomic comparisons suggest that collagen tubes are more effective at promoting nerve
regenerate than silicone tubes due to heightened levels of TGF 03, less a SMA expression, and
possibly decreased levels of TGF p1 at early stages of wound healing. Trends in protein
differences observed in nerve wounds treated with regenerative versus nonregenerative devices
are consistent with differences observed in wounds in the early fetal versus adult healing stages.
Results from this study support early fetal regeneration as a model for induced regeneration in
the peripheral nerve.
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Chapter 1: Introduction

Peripheral nerve regeneration is currently an important focus in biomedical and

bioengineering research because of serious complications, e.g. paralysis or loss of sensation,

which occur as a result of trauma to the nerve. Each year, about 200,000 patients in the United

States undergo surgical operations to treat peripheral nervous system (PNS) injuries (Madison et

al., 1992). The work of the MIT Fibers and Polymers Laboratory involves studying and

modifying the wound healing mechanism in vivo in order to prevent or lessen the clinical

consequences arising from these injuries. Severe PNS wounds spontaneously heal by closure

and scar formation instead of regeneration of functional tissue. When the damaged peripheral

nerve fails to regenerate or reconnect, stumps called neuromas form at both ends of the nerve,

resulting in a wound gap in between (Dellon, 1990). The gap disconnecting the proximal and

distal ends of the nerve trunk disrupts signal transmission to or from the central nervous system

and leads to loss of motor and sensory function.

Implantation of nerve tube devices to induce tissue regeneration between the ends of

severed peripheral nerve has been successful in the rat animal model over gap lengths on the

order of several millimeters (Yannas, 2001). To improve clinical outcomes, it is imperative to

optimize for the biomaterial device used as the implanted conduit for axonal growth across the

gap. Electrophysiological and morphological studies have demonstrated that collagen tubes

induce a better quality regenerate than the traditional silicone device (Chamberlain, 1998;

Spilker, 2000; Kemp et al., 2008). The regenerate formed from collagen treated wounds more

closely resembles and functions as nerve trunk. However, understanding of this outcome needs

to be further approached from a biochemical and biomechanical perspective.



This study was a protein level investigation of peripheral nerve regeneration induced by

collagen nerve tubes versus silicone tubes and is meant to complement the thesis work done by

Wong to probe whether differences in transcriptional activity could explain the clinical disparity

between the two biomaterial devices (2008). The experiments in the current study involved the

evaluation of rat sciatic nerves undergoing early stage wound healing with the aid of a collagen

or silicone treatment device. The ends of the transected nerve were separated apart by a 10 mm

gap. The nerve and regenerate were explanted two weeks post-operatively from the date of

transection and tube implantation. The involvement of various proteins present during wound

healing was determined through quantitative and qualitative biological assays such as enzyme-

linked immunosorbent assay (ELISA), immunoblotting, and immunofluorescence.

The hypothesis of this study was largely based on the paradigm that the change in

spontaneous adult wound healing to induced regenerative healing can be compared to the reverse

of the transition that is observed in early to late fetal wound repair. Unlike wounds in the late

fetal stage which close by contraction and scar formation, early fetal injuries are able to heal

spontaneously through regeneration and therefore serve as the desired clinical model for

inducing regeneration in adults (Yannas, 2005). To this end, much research emphasis was

placed on the members of the transforming growth factor beta (TGF P) protein family which are

thought to be antagonists or protagonists of regeneration due to their relative up or down

regulation in early to late fetal wound healing environments (Shah et al, 1995; Soo et al, 2003).

TGF 31, TGF 02, and TGF 03 are the three members of this family present in mammals, and

despite their homology, are hypothesized to play different roles in wound healing. This

conjecture was tested by measurement of each protein in peripheral nerve wounds undergoing

regenerative versus nonregenerative repair based on the use of a collagen or silicone treatment
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device. In addition, measurement of alpha smooth muscle actin (a SMA), a cytoskeletal

component of differentiated fibroblasts, was chosen to assess how the concentration of a protein

that has been associated with wound contraction might vary might alter in the healing milieus

inside a regenerative versus nonregenerative device. The roles of these proteins in wound

healing are described at greater length in Section 2.3.



Chapter 2: Background

2.1 Peripheral Nerve Wounds

2.1.1 Anatomical and Functional Context

The peripheral nervous system is comprised of the sensory, motor, and mixed nerves that

branch from the central nervous system to the periphery of the body. Inside the nerve are various

cell types, circulatory and lymphatic vessels, and connective tissue layers (Afifi and Bergman,

1997). Neurons, the primary unit of the nerve, and their supporting cells, known as Schwann

cells, are found in the innermost connective tissue layer called the endoneurium. Neurons are

structurally composed of dendrites, a 5-100 pm diameter soma (cell body), and a long, thin axon

that extends from the soma to a distal target in the periphery of the body. Signals are sent as

action potentials (electrical spikes) down the axon, which can be covered in insulating layers

known as the myelin sheath that helps signal conduction. In a normal nerve, the action potentials

arrive at the axon terminal which synapses with another neuron in the central nervous system to

deliver sensory information or at a neuromuscular junction to induce movement.

Within the nerve, axons are clustered in groups called fascicles, one or more of which are

ensheathed by the perineurium, another connective tissue layer (Afifi and Bergman, 1997). The

perineurium provides some tensile strength and elasticity to the nerve and acts as a diffusion

barrier between neurons and blood vessels. The epineurium is the outermost layer of loose

connective tissue containing blood and lymphatic vessels. It serves functionally as a structure to

dissipate mechanical stresses put on the nerve during incidents of trauma.



Figure 1. Cross-sectional anatomy of the peripheral nerve illustrating the connective tissue layers and
unmyelinated (left inset) and unmyelinated (right inset) axons (Lee and Wolfe, 2000).

2.1.2 Animal Model

This wound healing study

investigated differential protein expression

in two treatments of rat sciatic nerve

transection. The rat sciatic nerve has been
Feuar

a commonly used model to study PNS

wound healing (Lundborg et al., 1982;
Sclatc

Archibald et al., 1991; Chamberlain, 1996,
Tlbial

1998a; Chamberlain et al., 1998b, 2000; PeraeI/ Nerve
Nerve

Spilker, 2000; Harley, 2002; Wong, 2008). Figure 2. Anatomy of the rodent hind limb indicating the
location of sciatic nerve in relation to other anatomical

The sciatic nerve begins from the lumbar structures (Chamberlain, 1998).

region of the spinal cord and runs down through the buttocks into the lower limb. In the thigh,
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the sciatic nerve branches into the tibial and common peroneal nerves, which innervate the lower

leg and foot.

2.2 Wound Healing Response

2.2.1 Spontaneous Peripheral Nerve Healing

After peripheral nerve has been completely transected, the wounded neurons undergo

some degenerative processes and then make attempts at regeneration (Lee and Wolfe, 2000). The

entire soma swells in response to injury (Afifi and Bergman, 1997). The cell nucleus shifts from

the center of the cell body to periphery and organelles proliferate and enlarge in size. There is a

change in metabolic priority to produce new materials for axonal repair and growth: messenger

RNA; lipids; cytoskeletal proteins, e.g. actin, tubulin, and neurofilament protein; growth

associated proteins; and neuronotropic factors. The axon and myelin sheath undergo

degeneration. Macrophages invade the wound to phagocytose any fragments. An axon sprout

grows from the proximal stump and is mediated by growth cones to penetrate through the

extracellular matrix (ECM).

Full recovery can take from three months to half a year. If regeneration fails, the cell

atrophies and is replaced by glia. If the neuronal cell bodies are able to survive the injury, the

ideal wound healing outcome is reanastomosis, which involves the reconnection of axons to their

appropriate distal target. If the proximal and distal ends of the nerve fail to meet, caps at each

end of the trunk called neuromas form (Dellon, 1990).



2.2.2 Induced Regeneration using Tubulation

Regeneration of severed peripheral nerve has been induced with some success using

implantation of a tube device to bridge the wound gap between the disconnected nerve ends.

The ideal implant for nerve regeneration would consider the following factors: support and

possibly stimulation of axonal growth; resorption via the metabolic pathways of the host, with

the appropriate resorption kinetics to accommodate the time needed for axonal growth across the

gap; and nontoxic, nonantigenic, and noncarcinogenic properties as to not harm the host or

trigger an unreasonable immune response (Archibald et al., 1991). The use of tubulation as a

conduit for axonal growth through an interneural wound gap has existed for over 100 years,

though the devices have ranged in compositions from autografted naturally occurring tissues,

nondegradable synthetic materials, and degradable natural and synthetic materials (Fields et al,

1989). Silicone tubing was one of the original devices chosen for nerve repair and is used as a

benchmark to compare devices of other materials (Lundborg et al., 1982; Fu and Gordon, 1997).

Studies probing the regenerative ability of tubes composed of various biomaterials involve the

creation of a well-defined defect on an animal of study (Yannas, 2001). Full transection of the

peripheral nerve is performed on an animal model and the implanted device is sutured to the

nerve to bridge a gap of known length. The animal is allowed to recover from the surgical

procedure and the repair response of the peripheral nerve takes its course. After a prescribed

number of days, weeks, or months, depending on the timescale of study, the resulting wound

chamber, whose bounds are defined by the tubulation, now encompasses the transected nerve

trunks and any newly formed tissue and exudate present within the gap. The wound is explanted

at time points of interest and clinical assessments are made.



Investigators such as Chamberlain and Kemp et al. have compared the clinical outcomes

of treating peripheral nerve wounds with silicone tubes and collagen tubes (Chamberlain, 1998a;

Chamberlain et al., 1998b, 2000; Kemp et al. 2008). It was found that collagen tubes promote

superior nerve trunk regenerate than does the silicone standard at several gap lengths and

different time scales. Using a 10 mm gap model, collagen tube treated nerves displayed

improved clinical performance including farther axon growth, greater myelination, and enhanced

vasculation in measurements performed one to two months post-operatively, and in the longer

term, larger axon size and count, better conduction properties, and improved sensorimotor

recouperation. Table 1 is a brief listing of previously observed contrasts between 10 mm gap rat

sciatic nerve wounds treated with silicone and collagen devices found by Chamberlain et al. in

60 week post-operative measurements (1998a, 1998b, 2000).

Observations on Silicone versus Collagen Device Performance
Measurement on 10 mm gap Rat Sciatic Nerve Wounds, 60 Week Post-

Operative
About six times the area in collagen treated (0.58 ± 0.07) than inTotal tissue cable area
silicone treated (0.09)

Mean diameter of Twice as large in collagen treated (-~1.3 mm) than silicone (-.55
regenerate, center of gap mm)

About 50-60 times as many in collagen treated (-11,000) than
Myelinated axons per nerve silicone (-200)
Thickness of fibrous tissue
capsule at regenerate About ten times thicker in silicone treated than in collagen treated
periphery, center of gap
Table 1. Clinical comparison of rat sciatic nerve wounds treated with unfilled silicone or unfilled collagen
tube devices, 10 mm gap (Chamberlain, 1998a; Chamberlain et al., 1998b, 2000)

Tubulation studies of various gap lengths and time scales have found interesting morphological

and physiological disparities in the regenerate that resulted from bridging the nerve wound with a

collagen or silicone device. Archibald et al. have even shown the collagen device performing up

to the level of an autograft (2004), as did Chamberlain et al. (1998).

~



2.2.3 Theories of Peripheral Nerve Wound Healing

Given the disparity in device performance in the treatment of severed peripheral nerve, it

is important to gain understanding of the mechanism underlying wound healing to produce the

most efficacious devices. It has been observed that within hours of nerve transection and device

implantation, the implanted tube becomes filled with endoneurial fluid and axons begin

withdrawing from the distal stump. Within a week, a cable consisting of blood clot forms.

Depending on the implant characteristics, the amount of contractile capsule that forms on the

perimeter of the nerve trunk and of microtube synthesis by Schwann cells in the first few weeks

appears to determine whether a neuroma is formed and whether microtubes bridging the gap

enable axon elongation (Yannas, Zhang et al., 2007).

Several theories have emerged in an attempt to explain the phenomena which occur in

vivo during spontaneous nerve healing based on observations seen in experimental wound

chambers. These theories are the neurotrophic theory, contact guidance theory, pressure cuff

theory, and basement membrane microtubule theory. While each theory is supported by

empirical data, the mechanism underlying peripheral nerve wound healing is probably a complex

combination of these biochemical and biomechanical explanations.

2.2.3.1 Neurotrophic Theory

Neurotrophic theory attributes axon elongation and migration of supporting cells across

the interneural wound gap to the release of growth factors by the distal end of the wound

(Yannas, Zhang et al., 2007). The diffusion of growth factors across the gap towards the

proximal nerve trunk hypothetically acts as a guiding neurotrophic influence for proper

reanastomosis. In support of this theory, an inserted distal stump in a chamber containing a



proximal nerve stump allows for regenerative success over greater distances than an open ended

chamber (no distal stump) or ligated distal stump (Lundborg et al., 1982). However the theory

does not explain the large drop in regenerative success with a relatively small increase of gap

length. On its own, the neurotrophic theory cannot explain for the differences in clinical

outcomes in using cell-permeable rather than protein-permeable chambers or insoluble devices

with particular orientations.

2.2.3.2 Contact Guidance Theory

According to the contact guidance theory, axons are guided across the gap via contact

with and attachment to a substrate (Yannas, Zhang et al., 2007). Insoluble substrates within the

wound chamber, such as collagen-glycosaminoglycan (collagen-GAG) matrix filling, heavily

influences the outcome of regeneration (Chamberlain, 1998; Spilker, 2000). The existence and

structure of these substrates may be important in promoting regeneration because of adhesion of

cytokines that support that mode of repair. However, this theory does not explain the superior

regenerative activity of Schwann cell suspensions or of solutions of certain growth factors.

2.2.3.3 Pressure Cuff Theory

The pressure cuff theory pinpoints the activity of force-exerting cells as the determinant

in the healing outcome of wounded peripheral nerve tissue. Myofibroblasts are differentiated

fibroblasts exhibiting a contractile phenotype and are found in two orientations in the nerve:

axially aligned and circumferentially aligned (Chamberlain, 1996, 1998a; Chamberlain et al.,

1998b, 2000). The axially aligned cells are thought to exert a tensile force that may guide the

regenerating nerve trunk across the gap, while having to compete with the circumferentially
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aligned cells which form a contractile capsule around the proximal and distal nerve trunks to

compress the regenerating nerve radially. The contractile forces are responsible for neuroma

formation and the necking of the regenerate that is seen at the center of gap. The pressure cuff

theory plausibly accounts for why regenerative success of nerve in spontaneous healing and

induced regeneration studies is a function of gap length: as the gap length increases, contractile

forces prevail over the axial forces to form a neuroma before the axons from the proximal end

are able to elongate across to the distal target.

2.2.3.4 Basement Membrane Microtubule Theory

As experimentally observed in a nerve chamber, Schwann cells are found to migrate

ahead of all cell types along the fibrin cable that forms following flow of wound exudate. In the

absence of axons, basement membrane formation accompanying Schwann cell migration was

documented (Zhao et al., 1992). The two sets of data have led to the theory that Schwann cells

migrate along the fibrin cable and synthesize 10-20 mm diameter cylindrical basement

membrane microtubules in which axons can elongate and become myelinated (Yannas, Zhang et

al., 2007).

2.3 Early Fetal Repair as a Model for Regeneration

2.3.1 Spontaneous Late Fetal and Adult Wound Repair

In all organ systems, spontaneous adult mammalian response to injury is a three stage

process: inflammation, tissue formation, and remodeling (Gurtner et al., 2008; Yannas, 2001).

Inflammation occurs immediately after injury. Exudate, consisting of blood and extravascular

tissue fluid, flows into the wound site along with cells from neighboring tissues. The exudate



carries cytokines released by the injured neuron to further the inflammatory response by

attracting supporting cells, such as neutrophils and monocytes, and by promoting angiogenesis.

Coagulation and immune response occur to stop blood and fluid losses, to remove dead tissues,

and to prevent infection.

New tissue formation occurs a few days after injury and is characterized by cellular

proliferation and infiltration by different cell types. Fibroblasts which are attracted from the

edge of the wound are stimulated by pro-fibrotic cytokines released by differentiated monocytes,

known as macrophages, and they themselves differentiate into myofibroblasts. The

myofibroblasts produce and organize extracellular matrix (ECM), mainly consisting of collagen,

forming scar tissue that lacks the architecture and function of normal nerve tissue (Yannas, 2001;

Bottinger, 2008).

Remodeling of tissue begins a few weeks after injury and lasts for years. During this

stage, the trauma-induced acute inflammatory processes cease. Endothelial cells, macrophages,

and myofibroblasts undergo apoptosis or exit the wound (Gurtner et al., 2008).

2.3.2 Early Fetal Wound Healing

Unlike adults, mammalian fetuses during the first two trimesters have the ability to

spontaneously heal injuries by regeneration of tissue. During this early fetal stage, certain

organs, such as skin and long bones, are observed to heal with minimal inflammatory response

and without scar (Yannas et al., 2007). The ability to restore tissue with the same morphology

and functionality of the tissue existing prior to injury is of interest to the field of regenerative

medicine. Thus, the mechanism of early fetal regeneration serves as a model to induced adult
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regeneration, and differential protein observations found from early fetal to adult regeneration

motivated the protein selection of this study.

Cytokines are an important part in transitioning early fetal regeneration to late fetal and

adult repair. To better understand the mechanism of early fetal regeneration, investigators have

studied molecules that are differentially expressed between early fetal and adult wounds.

Observations have included decreased levels of pro-inflammatory cytokines including

transforming growth factor beta 1 (TGF 31) and 2 (TGF P2), interleukin 6 (IL 6) and 8 (IL 8),

platelet derived growth factor (PDGF), fibroblast growth factor (FGF), decorin, and tissue-

derived inhibitor of metalloproteinases (TIMP) in early fetal wounds (Krummel et al., 1988;

Whitby et al., 1996; Liechty et al., 1998, 2000a; Beanes et al., 2001; Dang et al., 2003). The

roles of these molecules include attracting fibroblasts and inflammatory cells, increasing

collagen synthesis and deposition, and stimulating wound contraction (Yannas et al., 2007).

Alternatively, fetal wounds demonstrate higher levels of vascular endothelial growth factor

(VEGF), hyaluronic acid, fibromodulin, metalloproteinases, TGF P3, and IL 10 (Colwell et al.,

2005; Longaker et al., 1991; Soo et al., 2000, 2003; Liechty et al., 2000b). The roles of these

molecules include promoting vascularization, modulating extracellular matrix (ECM), and

deactivating inflammatory cells (Yannas et al., 2007).

2.3.3 Proteins Investigated in this Study

This study chose to investigate differential TGF P and a SMA expression in tissue

regenerate induced by silicone or collagen tube treatment of peripheral nerve wounds. The

reasons for this protein selection were numerous. First, TGF P has already been researched in

wound repair across many organ types and this study serves as an extension of our knowledge of



its role in the PNS. Secondly, with an eye on the pressure cuff theory of wound healing, we are

interested in the activity of fibroblasts, which are considered the major effector in scarless repair

(Lorenz et al., 1995). TGF P has many regulatory functions including the differentiation of adult

and fetal fibroblasts to a myofibroblast phenotype that expresses a SMA (Rolfe et al., 2007).

The roles of these proteins tie in nicely with our overall objective: to gain a better understanding

of how to optimize in vivo induced regeneration. With this objective in mind, this proteomic

study looks downstream from the genomic focus on TGF P and a SMA done by Wong (2008).

2.3.3.1 Transforming Growth Factor Beta (TGF I) Family

TGF P regulates the production and degradation of the ECM and the adhesive

interactions between cells and the ECM in many cell types. Epithelial cells, fibroblasts,

monocytes, and macrophages produce and respond to TGF P (Bottinger, 2008). Because of this,

the protein family is responsible for the regulation of proliferation, apoptosis, differentiation,

migration, cell attachment, wound healing, and fibrosis. The involvement of TGF P in wound

repair first emerged over two decades ago when administration of TGF P to a wound chamber

was found to promote repair (Sporn et al., 1983). Since then, TGF 3, its receptors, signaling

molecules, and antibodies have been extensively studied for their roles in wound healing. TGF P

is released from activated platelets aggregated at the wound sites, recruiting monocytes and

macrophages. TGF P has been shown to induce fibroblasts to differentiate into their contractile

phenotype in vitro and in vivo (Desmouliere et al., 1993). Activated TGF P stimulates ECM

production by fibroblasts and is responsible for the synthesis and deposition of ECM proteins

including collagens, fibronectin, osteonectin, osteopondtin, tenascin, thrombospondin, biglycan,

and decorin (Schilling et al., 2008). TGF p31 has been shown to affect neuronal migration by up
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regulating cell adhesion molecules, neural cell adhesion molecule, and integrin subunits

(Siegenthaler and Miller, 2004). In both peripheral and central nervous system wounds, local

delivery of antibodies against TGF P was found to reduce fibrotic response and maintain or

restore functional integrity of the tissue (Nath et al., 1998).

TGF P31 and TGF 132 are known as pro-fibrotic cytokines that promote deposition of ECM

components and formation of scar during wound repair. Exogeneous addition of neutralizing

antibodies to these two cytokines in rat dermal wounds has shown to reduce the amount of

neovascularization, monocyte and macrophage presence, and deposition of fibronectin, collagen

I, and collagen III compared to control wounds (Shah et al., 1995). TGF 31 when added

exogenously induces scar in early human fetal wounds and amplifies its own expression. TGF

p31 mRNA and protein and TGF 32 mRNA have been found in higher concentrations in late fetal

(day 19) than early fetal (day 16) rat skin injuries (Soo et al, 2003). These findings contribute to

the hypothesis that heightened TGF p31 and TGF 32 levels are involved in the transition from

regenerative to nonregenerative wound repair.

Conversely, TGF 33 may favor the regenerative healing process through reduction of

scar. Topical application of TGF 33 has been shown to inhibit scar formation related to TGF p31

activity (Shah et al., 1995). In support of TGF 33's linkage to regeneration, Soo and colleagues

found that there were more TGF 33 mRNA and protein expression in dermal wounds inflicted on

16-day-old than on 19-day-old fetal rats (2003). In the study, day 16 rat skin wounds, which

demonstrated prolonged and higher levels of TGF 33 expression and decreased and transient

levels of TGF p31, repaired with organized collagen deposition, while the day 19 rat skin wounds

healed with disorganized collagen archictecture typical of late fetal fibrotic response. Despite

some evidence in support of the regenerative role that TGF 133 may play, the isoform is still



undergoing clinical investigations to determine whether it can prevent the pro-fibrotic activity of

TGF 31 (Bottinger, 2008).

The suggestive disparity between the isoforms' roles in wound healing is interesting

given that the peptide structures of the three members of the TGF-3 family are highly similar.

TGF 1pl is composed of 390 amino acids, while TGF P2 and 33 are slightly larger with 22

additional amino acids (Moses and Roberts, 2008). All the isoforms are composed of a N-

terminal signal peptide of 20-30 amino acids required for cell secretion, a latency associated

peptide (LAP), and a 112-114 amino C-terminus that becomes the mature TGF P molecule upon

cleavage. The mature molecules form 25 kDa disulfide-linked homodimers (Roberts et al.,

1983) and show 64-82% identity (Moses and Roberts, 2008). In measuring each protein for this

study, the homology between the three isoforms proved to be an obstacle that needed to be

addressed through determination and usage of isoform-specific antibodies.

2.3.3.2 Alpha Smooth Muscle Actin (a SMA)

a SMA, a protein composed of 375 amino acids, is present in the stress fibers of smooth

muscle cells, myofibroblasts, and pericytes (Skalli et al., 1989). It was determined that the

presence of this protein in a cell indicates the ability to exert contractile forces (Masur et al.,

1996). a SMA is the most commonly used marker for myofibroblasts (Gabbiani et al., 1998,

2002; Arora and McCulloch, 1999; Ronty et al., 2006). Presence of a SMA was previously

shown in a capsule on the periphery of the wound regenerate, especially in 60 week silicone

treated wounds where antibody stains were 10-15 cell layers thick, and sometimes in collagen

wounds where stains were 1 cell layer thick (Chamberlain, 1998a; Chamberlain et al., 1998b,

2000). In silicone treated wounds, the sheath of myofibroblasts has been observed throughout



the entire tabulated chamber, including around the proximal and distal stumps of the transected

nerve.

2.3.4 Transcriptional Comparison of Collagen versus Silicone Devices

Previous experimental work investigating the TGF P and a SMA mRNA expressions in

collagen and silicone treated rat sciatic nerve wounds showed significant differences in mRNA

levels at only a few time points when examined at 1, 3, 7, 14, and 21 days after implantation

(Wong 2008). The graphical results from Wong's study were converted into significant percent

increase statistics and tabulated in Table 2. A significant difference in TGF 31 expression

between silicone and collagen treated wounds only appeared on day 7 (p=.007), and TGF 32

expression between the two treatment groups were significantly different only on day 21

(p=.024). TGF 33 mRNA expression in collagen treated samples encountered a steep rise

(p=.0001) on day 14 that amounted to almost three times the level of expression in silicone

treated samples at the same time point. Wounds from both treatment groups experienced a slow

rise in a SMA mRNA expression for the first few days; however, after a week into the wound

healing response, the silicone treated samples encountered a significant increase in a SMA

mRNA expression (p=.0028) that was as much as three times the levels observed in collagen

treated samples by the third week (p=.0001).
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Table 2. Significant effects of treatment device (collagen or silicone tube) on TGF
SMA mRNA expression levels in whole peripheral nerve wounds (Wong 2008).
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Chapter 3: Materials and Methods

3.1 Implant Preparation

To distinguish between a regenerative and nonregenerative outcome following peripheral

nerve transection, one tubulation device with the consistent ability to reform nerve trunk across

the wound gap and another tubulation device lacking such ability were prepared according to

previous methods (Chamberlain 1998, Spilker 2000, Harley 2002, Wong 2008). Impermeable

silicone tubes are mostly observed to induce only connective, nonneuronal tissue when bridging

a nerve wound separated by a 10 mm gap, while porous, crosslinked collagen tubes are found to

have a greater ability to regenerate neuronal tissue at this length. Due to the disparities in

clinical outcomes as explained in Section 2.2.2, collagen and silicone were chosen as the

implants to be compared for protein level differences in regenerative versus nonregenerative

scenarios.

3.1.1 Silicone Nerve Tube Preparation

Silicone tubing (ID: 3.1 mm, Helix Medical, LLC, Carpinteria, CA) were cut with clean

and sterilized microscissors into 16 mm segments to prepare the silicone nerve tubes (Appendix

A.2). Each silicone segment was flushed twice with sterile phosphate buffered saline (PBS) and

deposited into individual, unused glass vials (Short Form Style with Phenolic Cap, Cat. No.

66011-063, VWR International). The vials were placed in a vacuum oven for 48 hours at 1200 C

for dehydrothermal treatment (DHT) and sterilization. Upon removal from the vacuum oven, the

vials were immediately sealed, collected into a larger autoclaved glass jar with a lid closure for

secondary containment, and stored in a dessicator with DrieRite Absorbent (VWR International,

Inc., San Diego, CA) until use in surgery.



3.1.2 Collagen Nerve Tube Preparation

Collagen tubes were fabricated by lyophilization of a 5% collagen slurry in a method

developed previously by Harley and used by Wong (Appendix A.1). 0.25 g of collagen I

(Integra Life Sciences, San Diego, CA) was dissolved in 4 mL of degassed, distilled water in a

10 mL Luer Lock syringe (Cat. No. 309604, Becton Dickson & Co., Franklin Lakes, NJ).

Gradually, 1.0 mL of glacial acetic acid (GAA, Mallinckrodt Chemical Co., Paris, KY) diluted to

a 3.0 M concentration, was added and mixed into the collagen-water suspension via a 1 or 3 mL

syringe with 22 gauge needle (Cat. No. 309574, Becton Dickinson & Co.). The 10 mL syringe

was connected to an empty 10 mL syringe using a female-female Luer Lock assembly (Stainless

steel Luer Lock tube fitting, female luer x female luer, Cat. No. 5194k12, McMaster-Carr Supply

Company, New Brunswick, NJ) and used to homogenize the collagen slurry from the transfer of

the slurry back and forth between the two syringes 10-15 times. The assembly was disassembled

and the collagen slurry was given time to swell in the closed 10 mL syringe for 3 hours at room

temperature. The swollen slurry was degassed by centrifugation at 4500 rpm for an hour total.

Approximately 0.25 mL of degassed slurry was injected into each cylindrical opening of

a specially designed Teflon and aluminum mold (Figure 24 and Figure 25) to produce tubes with

an outer diameter of 3.0 mm. Steel core mandrels (D: 0.032", Cat. No. GWXX-320-30, Small

Parts, Inc., Miami Lakes, FL) with Teflon coating (O.D. 0.056", I.D. 0.032", PTFE Tubing, Cat.

No. 06417-31, Cole-Parmer Instrument Company, Vernon Hills, IL) were inserted into the center

of the cylindrical openings to produce collagen tubes with an inner lumen of 1.5 mm diameter.

Teflon tubing (OD: 0.125", ID: 0.065", PTFE Tubing, Cat. No. 06407-42, Cole-Parmer

Instrument Company) were used as end caps to keep the mandrels centered and in place. The
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slurry-filled molds were placed in a freeze drier for 1 hour at -400 C before the frozen tubes were

freed from the mold using clean forceps and a razor. With the mandrels and end caps intact, the

tubes were placed onto an aluminum foil sheet and returned to the -40'C lyophilization chamber.

A vacuum was then used to reach a pressure of 200 mTorr or less. At this lower pressure, the

chamber was raised to 00 C and held at the temperature for 17 hours, after which it was raised to

200 C and the vacuum released for tube removal. The lyophilized tubes were carefully

transferred off the mandrels and placed in open pouches made from folded aluminum foil and

were ready for the subsequent cross-linking and sterilization process. The tubes underwent DHT

for 48 hours at 120 0C and approximately -29.8 mmHg. Upon removal from the vacuum oven,

the packets were immediately sealed and placed in a dessicator containing DrieRite Absorbent.

Before surgery, the DHT crosslinked tubes were cut into 16 mm segments in a sterile

biohood. The surface on which the tubes were placed and the forceps, microscissors, and razor

used to manipulate and cut the tubes were sterilized with 70% ethanol. The tubes were cut using

the central portion of the lyophilized product, omitting inconsistencies in the tube produced by

compressed slurry at the mandrel interface and any defects caused by removal of the tube from

the Teflon and aluminum mold. In the case that excess lyophilized collagen was attached to the

outside of the tube as a result of the gap between the top and bottom halves of Teflon and

aluminum molds, as much of the excess was carefully removed from the outside of the tube

using microscissors.

3.2 Implant Characterization

The purpose of this study was to investigate the proteomic disparities between a

peripheral nerve wound that healed with regeneration after treatment with a collagen tube and



one that healed without regeneration after using a silicone tube. The silicone and collagen

devices have dissimilar biomaterial properties, such as mechanical stress and strain

characteristics, permeability, degradation rate, swelling, protein adsorption affinity, that

undoubtedly have an effect on the in vivo immunological response. It has been shown that

altering properties such as pore size and extent of crosslinking even while keeping the

biomaterial composition constant can result in improvement or decline in the device's

regenerative ability (Chang 1991; Yannas 2001; Harley 2002). The porosity of the collagen tube

is a large determinant of the biological activity of the tube because pore size dictates whether the

device is cell or protein permeable and defines the surface density of ligands onto which cells

can bind and use in migration. Duration and temperature of dehydrothermal crosslinking

treatments have an effect on the structural rigidity of the collagen tube and in turn acts as

resistance to degradation of the tube in vivo. Therefore, it is of the utmost importance to state the

characteristics of the devices used in this study for experimental reproducibility and to define the

parameters responsible for the clinical results later shown.

The silicone tubes used in all surgeries were prepared from the same lot of tubing and

were considered consistent throughout this study. However, collagen tubes, while fabricated as

described in Section 3.1.2 from collagen provided by Integra, were made from different lots and

by different research assistants over a span of three years. The collagen tubes used in the ELISA

and immunoblotting studies were produced by Eric Soller and/or Kelly Chien from 2006 to

2007, while those used in the immunofluorescence study were produced by Kathy Miu in 2009.

Both sets of nerve tubes were produced under the optimal protocol determined by Harley but

with the following changes: lyophilizer model (VirTis Genesis EL versus LE) and closure

mechanism used on mold (c-clamps versus screws). The lyophilizer model used to produce the
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2009 tubes (VirTis EL) is much more efficient at a vacuum pressure of less than 200 mTorr

(minutes rather than hours). In addition, the VirTis EL is a more advanced model with

computerized controls and recorded thermocouple data. Due to these reasons, the VirTis EL was

a superior choice over the VirTis LE for current and future collagen tube fabrication. The 2009

implants used c-clamp closure over the screw to provide slightly more clearance for the

lyophilization of the tube. This resulted in fabrication of collagen tubes that were less prone to

sticking to the Teflon surface and fracturing upon removal from the mold.

Characterization was performed on the tubes produced from 2006 onwards (Table 3) in

order to confirm that the tubes implanted were consistent with those tested by Harley as having

regenerative properties. Microscopic techniques were used to determine the porosity of 2006

collagen tubes that were remaining in the dessicator in addition to newly fabricated 2009 nerve

tubes in the two lyophilizer models. The results were then compared to those empirically

determined by Harley (2002).

Fabricated Year of
Group Fabrication Lyophilizer Used Descriptionby Fabrication

48 hour DHT crosslinked;
Kelly Chien, VirTis Genesis ' hA Chien, 2006VirTis Genesis horizontal orientation; mold with

unknown closure
48 hour DHT crosslinked;

VirTis Genesis
B Kathy Miu 2009 LE horizontal orientation; mold with

LE
screw closure
48 hour DHT crosslinked; vertical

VirTis Genesis
C Kathy Miu 2009 EL orientation; mold with c-clamp

EL closure
Table 3. 48 hour 120C DHT crosslinked collagen tubes (groups A, B, and C) used in pore size
characterization

The tube types A and C studied were chosen on the basis of gathering information on the devices

implanted in surgeries from 2006 to 2009. However, characterizing tubes used in pre-2009

studies proved to be a challenge because examining tubes fabricated in 2006 (group A) for



properties it had in 2007-2008 has its share of problems. Tubes in group A were kept in an

aluminum foil packet in a dessicator with modest changes of DrieRite Absorbent over the course

of three years. Gelatinization and degradation of these tubes were highly probable given the

extent of storage. Thus tubes in group B were fabricated in the same lyophilizer and with the

same mold closure in an attempt to reproduce what is believed the tubes in group A should have

looked like and behaved closer to the time of implantation. The C tubes fabricated in the VirTis

Genesis LE were used in 2009 immunofluorescence surgeries. Tubes B and C were

characterized to confirm regenerative activity of the implants used in the proteomic

investigation.

3.2.1 Determining Collagen Device Porosity

Scanning electron microscopy (SEM) was used to perform qualitative analyses of the

surfaces of the dry collagen tubes. 1-3 mm nerve tube segments were imaged with a LEO

VP438 microscope using the LEO Scanning Electron Microscope software. The tubes were

viewed from the cross sectional, outer lateral, and inner lateral perspectives under variable

pressure using the backscatter detector. The outer and inner surface views were achieved by

cutting segments laterally with a razor and placing each half in the appropriate orientation on a

small mounting stub. Qualitative analyses of the segments were made from visually inspecting

the tubes under 20x, 100x, and 200x magnifications.

To be more quantitative in characterizing the tubes, the porosity of the collagen devices

was determined with JB-4 embedded sections of nerve tubes per previously used methods

(Harley, 2002). Embedding the tubes with reagents from a JB-4 Kit (Cat. No. 00226-1,

Polysciences, Inc., Warrington, PA) allowed for thin slices (-6 gm) of the tubes to be sectioned



and stained for approximately single layers of collagen. In the JB-4 embedding protocol

described in Appendix A.9, DHT crosslinked nerve tubes were cut into 3-5 mm segments and

rotated overnight in 1.5 mL eppendorf tubes filled with 100% ethanol at 4°C. The nerve tubes

were transferred into new eppendorf tubes filled with an equilibrium solution composed of 50%

ethanol/50% catalyzed JB-4 A and rotated for 12 hours at 40 C. To allow for infiltration of the

embedding medium into the devices, the collagen tubes were moved into new eppendorf tubes

filled with 100% catalyzed JB-4 A solution and rotated over the course of three days at 40 C with

changes of fresh solution every 12 hours. The infiltrated tubes were then added to 2 mL of

catalyzed 96.2% JB-4 A solution/3.8% JB-4 B solution in a mold (Polyethylene Molding Cup

Trays, 6xl2x5mm, Cat. No. 16643A-1, Polysciences, Inc., Warrington, PA) that was kept chilled

over ice due to the exothermic reaction that occurs during embedding. The tubes were

manipulated or held in the embedding medium to ensure the proper orientation for cross

sectional and lateral sections using a 21 gauge needle. After 15 minutes, a plastic block holder

(Cat. No. 15899-50, Polysciences, Inc., Warrington, PA) was added to each sample and the mold

was moved to 40C where the JB-4 embedding medium was allowed to harden for 24 hours. The

samples were removed from the mold and allowed to air dry at room temperature while protected

from light. A microtome (Shandon Finesse ME, Thermo Fisher Scientific, Inc.) was used to

section approximately 6 ptm thick samples that were subsequently mounted on glass slides with

10% ammonium hydroxide. After overnight drying, the slides were stained with aniline blue and

coverslipped. An Olympus BX51 microscope was used to capture the scaffold slices at 4x, 10x,

and 20x magnifications. The linear intercept method (Appendix A. 10) was used to calculate the

pore size from the 10x images.



3.2.2 Results

The collagen tubes made in 2006 and left in the dessicator (group A) were studied under light

microscopy and SEM as a

means of retroactively

characterizing the collagen

devices implanted from 2006 to

2008. Using both imaging

techniques, the group A tubes

were found under cross-section

to have a collapsed pore

structure. Lateral views

indicated a sheet-like exterior
.5 mm

and inner lumen. The Figure 3. SEM images of collagen tubes from group A (a,d), group B
(b,e), and group C (c,f). (a-c) Lateral, inner surface view of nerve

gelatinization kinetics of the tubes. (d-f) Lateral, outer surface view of nerve tubes.

tube under dessication has not been studied, and it is unclear how much of the biological activity

of the tube had been lost before implantation, especially in the later surgeries. While the group

A tubes are probably no longer characteristic of the implanted tubes in the 2007-2008 surgeries,

they demonstrate an extreme case of degeneration of tube quality and serve as an example of a

poor choice to be used in in regeneration studies. It was previously stated (Harley, 2002) that

these tubes could be stored indefinitely in a dessicator with DrieRight Absorbent. However, due

to inefficiencies in the dessication method, e.g. the tightness of dessicator seal or frequency of

dessicant changes, it is clear that the quality of tubes should be evaluated on a case by case basis.
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1 mm

Figure 4. Cross sectional images of collagen tubes from groups A (a, d), B (b, e), and C (c, f). Analine blue
stained JB-4 embedded sections (a-c) and corresponding SEM images (d-f).

On the contrary, the cross sectional images of group B and group C tubes indicated open

pore structures when viewed with SEM and light microscopy. Using the linear intercept method,

it was found that tubes from group B were found to have a smaller pore size than tubes from

group C. A significant difference in the mean pore sizes were determined through an unpaired T

test (p<.0001).

Using a subset of collagen tube devices with different crosslinking temperatures and

times, Harley determined that out of the collagen tube devices he tested, the ones with the most

regenerative ability were his tubes DHT crosslinked for 48 hours at 1200 C and 900 C (2002).

These devices had mean pore sizes of 70 to 100 tm, respectively. While tubes used in this study
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Mean Pore
Device Diameter -+

SEM (um)
B 72.5 ±1.4
C 88.4 ± 1.3
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E 60.
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Table 4. Average pore size for 48 hour
1200C DHT crosslinked collagen tubes
used in 2008 and 2009 proteomic studies 0

B C

Collagen Device Group

Figure 5. Pore diameter (mean :± SEM) for 48 hour DHT
crosslinked collagen tubes used in 2008 and 2009 proteomic
studies

underwent 48 hour DHT crosslinking treatment at 1200C, the fabrication process involving

different lyophilizers and slight differences in mold closures had an effect on the device porosity.

However, despite the difference in porosity between the devices implanted in the ELISA and

immunoblotting surgeries and those used in the immunofluorescence surgeries, both pore sizes

fall in the range of the collagen tubes Harley found had regenerative activity.

3.3 Peripheral Nerve Regenerate Procurement and Storage

3.3.1 Experimental Samples

Left sciatic nerve surgeries were performed on 17 adult female Lewis rats (150-200 g,

Charles River Laboratories, Wilmington, MA) by Dr. Hu-Ping Hsu at the Boston VA Medical

Center with the aid of Eric Soller in 2007 and both Soller and Miu in 2008. The surgical

protocol, described in Sections 3.3.1-3.3.4, was adapted from the protocols of earlier researchers

(Chamberlain, 1998a; Spilker, 2000; Harley, 2002; Wong, 2008). Eight animal wounds were
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treated with collagen tubes fabricated in 2006 and 2007 by Soller and/or Kelly Chien (estimated

mean pore diameter: 72.5 pm), while nine were treated with silicone nerve tubes. The

processing of the explanted wound was developed by Soller and used by Wong (2008). When

mass data for the samples, to be used as a means of normalization, was collected before tissue

digestion, ELISA was performed. The resulting numbers of animals used in ELISA were seven

for the collagen treated group and six for the silicone treated group. Due to normalization by

cellular content rather than mass data with the immunoblotting assay, samples missing mass data

were able to be included in the study. For immunoblotting, the collagen treated group had a

sample size of eight and the silicone treated group had a sample size of nine. For both assays,

animal wounds were sectioned into five segments as later described in Section 3.4. The ELISA

and immunoblotting assays were performed on tissue segments from each animal wound ("per

segment" analysis) and the measurements were pooled per animal and averaged for each

treatment group ("whole wound" analysis).

In 2009, left sciatic nerve surgeries were performed on nine adult female Lewis rats (200-

230 g) for an indirect immunofluorescence study. Five wounds were treated with collagen tubes

fabricated in 2009 by Miu (mean pore diameter: 88.4 gim) and four were treated with silicone

nerve tubes. The same surgical procedure as above was followed, though the processing of the

explant differed (Section 3.3.6). 6 gm thick cross-sectional slices of each nerve sample were

compared at five locations along the nerve using immunofluorescent analysis.



Treatment Group

Collagen Tube Silicone Tube

ELISA 7 7

Assay Immunoblotting 8 9

Immunofluorescence 5 4
Table 5. Sample sizes for treatment groups studied with ELISA, immunoblotting, and immunofluorescence.

3.3.2 Surgeries and Device Implantation

Surgeries took place at the Boston VA Medical Center. Sodium pentobarbital (50 mg/kg

of animal) was used to anesthetize the Lewis rat prior to surgery. The left leg of the rat was

shaved in addition to the area from the base of the tail to the middle of the back to expose the

surgical region. The wounding and device implantation to follow were performed by the

surgeon using sterilized equipment. An incision was made into the leg and the sciatic nerve was

transected midway between the
Sutures

proximal nerve trunk and the distal Tube Sutures

bifurcation to produce the peripheral

3 mm 1 10 mm 13 m4
nerve wound. Marks were made 3

Figure 6. Use of implanted tube to bridge 10 mm gap between
mm inwards from the nerve ends to proximal and distal ends of sciatic nerve wound (adapted

from Chamberlain, 1998).

indicate the site of attachment for the

nerve tube implant. The nerve ends were inserted into the implant and secured by 10-0 sutures

that penetrated through both the epineurium and the tube. The leg was stitched and stapled to

close the wound.

Rats were allowed to rest after surgery in individual recovery beds with delivery of

oxygen through masks. Surgeries were performed on four or fewer rats per day. For each rat,

subcutaneous injection of 0.1 mL of 0.15 mg/mL Ketofen, 0.1 mL of 100 mg/mL Cefazolin, and
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1 mL Lactated Ringer's Solution were given. Once regaining consciousness, rats were moved to

individual cages with fresh bedding, food, and water.

3.3.3 Post-Operative Care

The subjects were visited by the graduate research assistant every 24 hours for 48 hours

following the operation for post-operative care. During each visit, the rats received

subcutaneous injections of 0.1 mL of 0.15 mg/mL Ketofen and 0.1 mL of 100 mg/mL Cefazolin.

3.3.4 14-Day Post-Operative Sacrifice

A carbon dioxide chamber was used to sacrifice the rats 14 days after the device

implantation. The leg wound was reopened, and the implant, enclosed nerve tissue and

regenerate, and excess proximal and distal nerve tissue were excised. The distal end was marked

with a tissue marker to denote the orientation of the explant. The explant was photographed and

processed depending on the biological assay to follow suit.

3.3.5 Tissue Processing for ELISA and Immunoblotting

For the samples used in the ELISA and immunoblotting studies, R-40 Peel-A-Way

Embedding Molds (Cat No. 18646C-1, PolySciences, Inc., Warrington, PA), were labeled for the

proximal and distal ends of the nerve wounds and were partially filled with room temperature

optimal cutting temperature (OCT) compound. Samples (tissue and implant device) were

deposited into the mold in the proper orientation, covered with additional OCT, and then

immediately frozen in liquid nitrogen. This freezing method allowed for the collection of sample



tissue and exudate with minimal diffusion after excision. The samples were transferred to a -

800C freezer for long term storage.

When ready for sample segmentation, the OCT-embedded tissues were transferred from

the -800 C freezer to a microtome-cryostat chamber equilibrated at -250C. The R-40 Peel-A-Way

Embedding Mold was stripped off each sample by cutting the containers at each corner with

scissors. The OCT-embedded sample was then attached to a mounting block with addition of

room temperature OCT and allowed to harden in the microtome-cryostat. The mounted sample

was installed into the microtome, and the OCT was cut away in slices until the nerve sample and

implant device were exposed. A razor was used to continue removing any excess OCT and to

section the nerve sample into five segments.

Proximal 3-4 mm 2-3 mm 2-3 mm 2-3 mm 3-4 mm Distal
Nerve Nerve
End End

Segment #: 1 2 3 4 5

Figure 7. Segmentation of nerve samples into five -3 mm segments with the requirement that segment 1
contain the proximal nerve stump and that segment 5 contain the distal nerve stump (adapted from Wong,
2008).

In accordance with Wong's protocol, segments 1 and 5 were cut such that their

boundaries were defined by the proximal and distal nerve trunks, respectively. This

methodology allowed for the segments to be more appropriately compared for cytokine content

across different animals and treatment groups. Containing the nerve stumps in the end segments

usually resulted in segments 1 and 5 being greater than 3 mm in length. Segments 2 through 4

were then -. 5-1 mm smaller, but equal and adjacent divisions of the explant existing in the

remaining interneural wound gap. The segments were in most instances massed and in all



instances deposited into individual mini eppendorf tubes. For the silicone treated wounds, the

segments were carefully removed from the silicone tube using sterile forceps before being

massed and placed into individual containment. Due to the attachment of the nerve regenerate to

the collagen device, collagen treated samples were processed with the implant intact. Masses of

the nerve segments were calculated by subtracting the mass of the empty mini eppendorf tube

from the mass of the tube after insertion of the nerve segment. Segments generated prior to this

study were not massed because the Wong preparation did not use mass as a means of

normalization. The mass data was collected after it was determined to be a useful statistic in

normalizing the ELISA data. Therefore, some unused samples leftover from earlier studies

could be used in the immunoblotting assay but not contribute data for ELISA.

3.3.6 Tissue Processing for Immunofluorescence

Samples used in the immunofluorescence study followed an alternative processing

protocol (Appendix A.8) in which the explants were formalin fixed and paraffin embedded.

Formalin is an aldehyde fixative that achieves good penetration of tissues, forming crosslinks

between basic amino acids to stabilize the proteins in situ (Millipore). After formalin fixation,

paraffin is used to embed the tissue. Paraffin can be melted, dissolved by xylenes for infiltration

of tissue, and then turned to solid state for structural support of the tissue during sectioning.

Paraffin is the most commonly used embedding medium because it provides for excellent

morphological detail and resolution in immunostaining techniques.

The peripheral nerve explants, cut with approximately 1 mm of excess tissue at each of

the proximal and distal ends, were placed into specimen containers (4 V2 oz Graduated Wide

Mouth with Screw Lid, Cat. No. 17000, Kendall Healthcare Products Co., Mansfield MA) with



20mL of Yanoff's fixative for 24 hours at 40 C. The explants were then moved to clean specimen

containers with 20 mL of 10% buffered formalin for another 24 hours at 40 C. Lastly, the

explants were rinsed with 70% ethanol, photographed, and stored in clean specimen containers

with 70% ethanol at 40 C until ready to be processed for paraffin embedding.

Formalin-fixed samples were taken from the 70% ethanol solution used for storage and

placed into individual TRUFLOW Tissue Cassettes (Cat. No. 15-200-403E, Thermo Fisher

Scientific, Inc., Rockford, IL) that were placed into a TP 1020 tissue processor (Leica,

Bannockbum, IL). The tissue processor dehydrated the fixed samples in a series of graded

ethanol solutions and xylenes before infiltration in paraffin. The explants were removed from

the machine, sectioned into five 3.5-4 mm pieces using a razor (Figure 8), and positioned distal

end first into separate embedding molds of warm paraffin. The containers were cooled using a

cold plate to preserve the orientation of the explants. The paraffin embedded samples were

stored for 24 hours at -200 C, removed from the molds, and returned to -200 C until sectioning.

The sections were made in 6 gm thick cuts and mounted as duplicates or triplicates onto

microscope slides. The slides were air dried for an hour and then moved to a slide warmer for an

additional hour before long term storage in a slide box at room temperature.

Proximal Distance from proximal end of tube (mm) Distal
Nerve I Nerve
End 4 0 3 . 10 13.5 t1 17 End

Segment #: 1 2 3 4 5

Figure 8. Segmentation of samples into five 3.5-4 mm pieces for paraffin embedding. Locations are in
reference to proximal end of implant.



3.5 Enzyme-linked Immunosorbent Assay (ELISA)

3.5.1 Concept

The ELISA method is used to quantify proteins based on the concentration-dependent

absorbance properties of a solution. There are various forms of ELISA depending on whether

the sample is bound to the plate and the antibody applied, or the antibody bound to the plate and

the sample applied. In the method in used in this study, the sandwich ELISA, a primary antibody

against the antigen of interest is coated onto a 96-well plate and is used to capture antigen in the

sample. After the capture antibody is effectively bound to the wells of the plate, he samples to

be analyzed are deposited into the wells. Any antigen present within the sample is given time to

bind to the primary antibody. The unbound portion of the sample is then washed out, and

another primary antibody, with a different epitope binding region than that of the capture

antibody, sandwiches the antigen and is used as a detection antibody. A chromogenic reaction

with the detection antibody is induced, and a set wavelength is used to test the absorbance of the

solution in a plate reader, providing an optical density measurement.

A standard curve is developed by performing ELISA on graded concentrations of the

protein of interest and generating a fitted curve from the optical density measurements for each

known concentration. The optical densities from the unknown samples are compared to the

plotted curve to back calculate the amount of antigen that was present in the well. Sample

masses obtained prior to the tissue segment digestion were used to produce a protein content

statistic normalized by mass.



3.5.2 Discussion ofAssay Choice

The ELISA method is the most quantitative way to determine protein concentration in

unknown samples. The test results in samples are defined in absolute concentration of protein.

To minimize error generated by differences in day-to-day test conditions, a standard curve is

generated with each run so that the optical densities of the unknowns are always compared with

the optical densities of the known wells for every test. The ELISA was thus explored as the

primary assay of choice.

However there are disadvantages to the ELISA method that complicated its use. First,

the antigen of interest must be extracted or produced as a recombinant protein and subsequently

purified. The quantity of antigen amassed must be sufficient enough to be detected by ELISA

and be used to produce a range that includes the quantity of protein in the unknown samples.

Secondly, appropriate capture and detection antibodies for the antigen must be procured for the

sandwich assay. The detection antibody must bind to an epitope site different from the capture

antibody, and that site must remain freely accessible once the antigen has bound to the capture.

The chromogenic reaction that follows should only be dependent on the concentration of

detection antibody; this usually requires that the detection antibody generated from a different

host species than the capture antibody. The choice of antibodies is critical because the sensitivity

of the ELISA is determined by the binding properties of the primary antibodies to the antigen.

Next, handling of the unknown samples for ELISA testing varies depending on whether the

samples assayed are from cell culture or tissue lysate. If tissue lysate is used, as was the case in

this study, the final absorbance measurement can be inaccurate based on the digestion buffer

used to process the tissue. Therefore, there must be optimization for the digestion buffer to
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produce the least background signal. For these reasons, it may not be possible to use ELISA to

quantify all proteins.

3.5.3 ELISA Method

A rat-specific sandwich ELISA kit containing all the necessary solutions and antibodies

for measuring TGF p31 (Cat. No. MB 100B, R&D Systems, Minneapolis, MN) was used to assess

the concentration level differences in collagen versus silicone tube treated rat sciatic nerve

samples. Digested tissue samples were taken from the -20 0C freezer and acidified for 15 minutes

with 1 N HCl in order to activate any TGF 31 to the mature form (Brown et al., 1990). Tissue

samples were then neutralized with 1 N NaOH and diluted with a calibration diluent. The

samples and known concentrations of TGF p3 standard ranging from 0 to 2000 pg/mL were

added to wells of a 96-well plate pre-coated with TGF p31 capture antibody. The TGF p1 present

in the sample and standards were given 2 hours to bind to the plate while shaking at room

temperature. The wells were then emptied of liquid content and washed three times with wash

buffer to remove any unbound material. A horseradish peroxidase (HRP) conjugated TGF 31

detection antibody was added to the well to detect the antigen, and the plate was left shaking at

room temperature for another 2 hours. The wash step was repeated three more times to remove

unbound detection antibody. A concentration-dependent A+B color reagent was used to visibly

indicate the levels of TGF p1 conjugate bound to the antigen. The reaction was allowed to

develop for 30 minutes at room temperature, and then finished by adding an acid stop. A

SpectraMAX 340PC plate reader (Molecular Devices, Sunnyvale, CA) was used to analyze the

optical density from the wells using a 450 nm wavelength as a measurement and 540 nm

wavelength as a correction factor.



In this study, fabrication of sandwich ELISAs for TGF 32 and TGF P3 were attempted

using high binding affinity 96 well plates, various combinations of monoclonal and polyclonal

primary antibodies, a HRP-conjugated secondary antibody, and the color detection reagents left

from the TGF P31 kit. However, due to any number of complications specified in Section 3.1.1, a

standard curve failed to be produced over a large concentration range over three orders of

magnitude. Therefore, immunoblot analyses were the primary method of assessing the relative

differences in TGF 32 and TGF 33 levels between collagen and silicone tube treated samples.

ELISA was not performed for measurement of a SMA due to the inability to purchase or purify

protein standard.

3.5.4 ELISA Data Analysis

As per the kit instructions, a standard curve was developed by fitting a 4-parameter

logistic to the optical density data obtained from the plate readings of known TGF 3 1. The

optical densities from the rat tissue samples were compared to the standard curve to empirically

determine the TGF p31 concentration for each well. The digestion buffer of the rat tissue samples

was optimized to produce the least background noise in this step. The concentration calculated

was then converted to a ug TGF p1 per g explanted tissue segment statistic by the method

described in Appendix A. 13 and summarized by the equation:

- x]Vf .10-3

m Zv m

where x is the mass of TGF p31 present in the sample in ug, m is the mass of the explanted tissue

segment in g, [x] is the concentration of TGF 31 in the segment as determined by ELISA in

ug/mL, Vf is the final volume of the diluted tissue sample prior to insertion into the wells, and



Xv is the volume fraction of the aliquot taken from the digested sample. As earlier described in

Section 3.4, the mass of the tissue segment, m , was calculated using the difference in masses

between a mini eppendorf tube prior and after the deposition of the segment. The concentration

of TGF 31 in a segment sample, [x], was determined using the standard curve described above,

which was developed from plotting known concentrations of TGF P31 against optical density

measurements. Vf was the volume of the sample after the dilutions with 1 N HC1, 1 N NaOH,

and calibration diluent. ,v was the volume ratio of the aliquot to the digested sample, which in

this study was 1/5, after taking 10 [tL to test in ELISA from a 50 tL sample stock. The 10-3 was

used in unit conversion to express the mass protein over mass tissue statistic in ug/g.

3.6 Immunoblot Assay

3.6.1 Concept

The immunoblot technique can be used to semiquantitatively determine the amount of

protein in a sample based on measuring a concentration-dependent chromogenic or

chemiluminescentreaction that occurs at the site of interest. Electrophoresis is performed on the

sample such that proteins in the test sample migrate through the gel based on molecular weight.

A protein ladder containing proteins of known molecular weights is run simultaneously with the

unknown samples to locate the approximate band site of the antigen. The proteins are transferred

from the gel to a membrane onto which antibodies can be applied to the sample. A primary

antibody against the protein of interest is used to locate the antigen, and a secondary antibody

conjugated to a molecule involved in a color changing or light emitting reaction is used to detect

the primary antibody. A chemiluminescent reaction, chosen to greater sensitivity, was induced

and the light emission from the sample lanes are captured and compared. To normalize, an



immunoblot with a loading control is used to determine the amount of cellular content from each

sample.

3.6.2 Dicussion ofAssay Choice

Though the immunoblot technique is less quantitative than the ELISA method, the

advantages the immunoblot technique has over the ELISA method allowed for the comparison of

all proteins in this study. First, only one primary antibody is needed to detect the antigen; this

eliminates complications with finding antibodies with epitope sites that do not conflict. The

choice of antibody is further discussed in Section 3.6.2. Secondly, protein standard is not a

requirement in relatively assessing the amount of protein in one sample from the next. Thus the

immunoblot assay is apt for comparing protein concentrations in samples on a relative basis.

3.6.2 Assessment ofAntibody Specificity

The objective of the immunoblot assay is to measure the amount of a specific protein

present in a sample; therefore it is in our interest to utilize the antibody with the highest binding

affinity for the antigen while keeping cross-reactivity and nonspecificity minimal. Commercially

available from numerous vendors are a plethora of antibodies that range from the animal source

of the antigen that the antibody was raised against, the host species in which the antigen was

introduced to produce an inflammatory response, and the clonality of cells that generated the

immune response to the antigen. An a SMA mouse monoclonal antibody (Cat. No. A5228,

Sigma-Aldrich, St. Louis, MO) previously used in immunohistochemical stains by Chamberlain

and Spilker, was tested with a human smooth muscle cell control in immunoblotting to confirm

banding at the appropriate molecular weight location. Due to the homology of the TGF 3
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isoforms, antibody specificity was a major concern. The determination of antibody specificity is

commonly tested using dot blot tests (Ermens et al, 1997; Guo et al, 2006). Dot blot tests

(Appendix A.14) with positive and negative controls (Table 6) were conducted for the TGF P31,

TGF 32, and TGF 33 primary antibodies considered candidates for the assay (Table 7). For each

antibody, the isoform for it was raised was the positive control, bovine serum albumin (BSA)

was the negative control, and binding to the other isoforms was in question. Strips of an

Immobilon polyvinylidene fluoride (PVDF) membrane (Cat. No. IPSN07852, Millipore,

Billerica, MA) were soaked in methanol for 20 seconds and rinsed in distilled water. An alcohol

and waterproof marker was used to label each strip for the antibody to be applied in addition to

the areas where each protein would be spotted. Using a pipette, proteins were spotted onto the

PVDF strips according to their designated location and allowed to dry before proceeding.

Antigen Source Vendor Cat. No.

TGF 31 Human recombinant Peprotech 100-21

TGF 32 Human recombinant Peprotech 100-35B

TGF 33 Human recombinant Peprotech 100-36

BSA Bovine Roche Diagnostics 03116999001
Table 6. Proteins used as positive and negative controls to assess TGF P antibody specificity.

Once the protein spots were air dried, the strips were rotated in a 5% nonfat milk in Tris buffered

saline (TBS) blocking solution. The blocked membrane strips were transferred into diluted

primary antibody solution for an hour and washed three times with 0.5% Tween 20 in TBS wash

buffer. Due to the heightened signal produced from polyclonal antibodies over monoclonal

antibodies, the former were diluted 1:800 while the latter were diluted 1:500 in 0.33% BSA,

0.5% Tween 20 in TBS dilution buffer. The washed membrane strips were transferred to tubes

filled with the relevant 1:5000 diluted HRP-conjugated secondary antibody for detection of the



mouse (Cat. No. 31340, Thermo Fisher Scientific, Inc., Rockford, IL), rabbit (Cat. No. 31460,

Thermo Fisher Scientific, Inc.) or goat (Cat. No. 31402, Thermo Fisher Scientific, Inc.) primary

antibodies.

Isoform
Antibody Sifiity Host Clonality Vendor Cat. No.

Specificity

A TGF 31 Mouse Monoclonal Abcam ab10517

B TGF 31 Mouse Monoclonal Peprotech 500-M66

C TGF [2 Mouse Monoclonal R&D Systems MAB612
Santa Cruz

D TGF [32 Rabbit Polyclonal Biotechnology sc-90

Santa Cruz
E TGF 32 Goat Polyclonal Santa Cruz sc-31610

Biotechnology

F TGF [3 Mouse Monoclonal R&D Systems MAB643
Santa Cruz

G TGF [3 Rabbit Polyclonal Santa Cruz sc-82
Biotechnology

Table 7. Primary antibody candidates for use in TGF p immunoblots.

After an hour of rotation in the solutions, the membrane strips were washed three times in

wash buffer and exposed to 150 .L of mixed 1:1 chemiluminescent reagent and enhancer

(SuperSignal West Femto Chemiluminescent Substrate, Cat. No. 34095, Thermo Fisher

Scientific, Inc.) for five minutes at room temperature on a microplate shaker. The resulting

chemiluminescence from the strips were digitally captured using an FluorChem 8900 imager

(Alpha Innotech, San Leandro, CA). Antibodies were evaluated qualitatively using the

following metrics: isoform specific binding, cross reactivity to alternative isoforms, nonspecific

binding to negative control, and background staining.

3.6.3 Antibody Choice

All antibodies, with the exception of one case (E), bound to their positive control spot

(the isoform they were raised against) and did not bind to the negative control spot (BSA). The

1 Y~



goat anti-TGF P2 antibody E failed to bind to any protein and was immediately discounted from

use in the immunoblot assay. Polyclonal antibodies (D, G) had the strongest signal to the

specific isoform they were raised against, but had high nonspecific binding to another isoform

and moderate background noise. Typically, monoclonals (A, C, F) clearly showed specificity to

their isoform but signal was oftentimes weaker than that generated from the polyclonal bound

spot. An exception, monoclonal antibody B, produced very strong

but also to TGF 02 and the blocked PVDF membrane.

signal to its isoform, TGF p1,

TGFAI F T 2 TGF P3 BSA

anti-
TGF P1 B

C

anti-
TGF P2

LE

F
anti-

TGF p3

G

I

Figure 9. Dot blot results for antibody
binding to TGF P1, TGF P2, TGF P3, and
BSA (negative control) protein spots.

TGF TGF TGF
BSA

Antibody pl P2 P3 spotspot spot spot
A + - - -

B ++++ ++ - -

C - ++ - -

D ++ +

E .

F - - + -

G - ++ ++ -
Table 8. Evaluation of antibody binding to protein spots in
dot blot test. The number of pluses indicate relative amount
of intensity, while a minus indicates no intensity from a spot.

Antibody Background

A

B +

C

D ++

E ++

F

G ++
Table 9. Evaluation of antibody binding to the PVDF
membrane. The number of pluses indicate relative amount of
intensity, while a minus indicates no intensity from a spot.
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Due to the goal of the study to quantify the isoform specific concentrations in the regenerative

and nonregenerative wounds, the most specific primary antibodies would provide the most

accurate results. Thus mouse monoclonal antibodies against each TGF 3 isoform (A, C, F) were

chosen for use in the immunoblot measurements.

3.6.4 Immunoblot Method

In an immunoblotting protocol described in Appendix A.15, digested rat sciatic nerve

samples from the -20 0 C freezer were diluted 1:4 with distilled water and 1:2 with a previously

diluted 2X Laemmli SDS-Sample Reducing Buffer (Cat. No. BP-110R, Boston BioProducts,

Inc., Worcester, MA). The samples were vortexed, heated for five minutes at 1000 C, and upon

cooling, centrifuged for two minutes. The samples were loaded into separate wells of 4-15%

Ready Gel Precast Gels (Cat. No. 161-1122, Bio-Rad Laboratories, Hercules, CA) and inserted

into an electrophoresis/transfer module (Mini Protean Tetra Cell, Cat. No. 165-8030, Bio-Rad

Laboratories). 35V was applied across the gel (300V Power Source, VWR International) in the

electrophoresis setup to promote movement of the proteins in an arrangement by molecular

weight. The gels were then moved to a blot transfer cassette and returned to the Mini Protean

Tetra Cell where a 50 mA current was applied at 40 C for three to five hours as determined by

previous optimization. Upon successful transfer, the protein lanes were bound to a PVDF

membrane (Cat. No. IPSN07852, Millipore). Unbound areas of the membrane were blocked for

an hour with 5% nonfat milk buffer in TBS to prevent the antibody from nonspecifically binding

to the PVDF. Primary and secondary antibodies used in the immunoblotting study (Table 10)

were all diluted with 0.33% BSA, 0.5% Tween 20 in TBS. The PVDF membrane was incubated

at room temperature for two hours in a diluted primary antibody solution on a rocker and then



washed six times in 0.5% Tween 20 wash buffer at five minutes per wash. Exposure of the

membrane to secondary antibody solution occurred at room temperature on a rocker for an hour

followed by another six washes in wash buffer and one wash in distilled water to remove traces

of Tween 20.

Antibody Type Dilution Vendor Cat. No.

Anti-TGF p31 Mouse monoclonal, primary 1:500 Abcam ab10517

Anti-TGF P2 Mouse monoclonal, primary 1:500 R&D Systems MAB612

Anti-TGF P3 Mouse monoclonal, primary 1:500 R&D Systems MAB643

Anti-a SMA Mouse monoclonal, primary 1:1000 Sigma-Aldrich A5228

Anti-a Tubulin Mouse monoclonal, primary 1:2000 Abcam ab7291

Anti-mouse Goat, secondary, HRP-conjugated 1:5000 Thermo Scientific 31340
Table 10. Primary and secondary antibodies used for immunoblot detection

Chemiluminescent reagent and enhancer (SuperSignal West Femto Chemiluminescent Substrate,

Cat. No. 34095, Thermo Fisher Scientific, Inc.) were mixed 1:1 to make 1 mL of solution per

blot and shaken with the membrane for five minutes at room temperature. The membrane was

transferred to the FluorChem 8900 and captured at one, three, and ten minute exposures. The

process was repeated for each sample using an antibody against a Tubulin which, as a major

component of microtubules, is a measure of cellular content and is commonly used in

immunoblotting as a loading control. Normalization for amount of cells per sample was

achieved using the chemiluminescence data gathered from blots probed for a Tubulin at a one

minute exposure.

3.6.5 Immunoblot Data Analysis

For the group of membranes to be analyzed for each protein, the length of exposure was

chosen based on the intensity of the protein bands visible at B=0, W=255, G=1.0 settings in the



AlphaEaseFC software. The quality of the image was determined by visual inspection with

confirmation from the histogram levels. Bands were checked for their sizes using lanes

containing known molecular weight markers (Precision Plus Protein All Blue Standard, Cat. No.

161-0373, Bio-Rad Laboratories). The TGF 13 isoform bands were measured at 25 kDa and a

SMA was measured at 42 kDa. The rectangle tool was used to define the perimeter of the

protein band or bands of interest in the sample lanes. Background intensity was automatically

determined for each band as the average of the ten lowest intensities contained in the rectangle.

The software generated an average intensity statistic per unit area for each protein band with

subtraction of the background intensity. The intensities for each sample were compiled into a

spreadsheet to be normalized with the corresponding spot densities from the a Tubulin

immunoblots.

Two-way ANOVA and student's T-tests were used to compare the effects of device and

segment on protein expression from the intensities. The segment data were pooled by animal

and then analyzed on a whole wound basis. The total wound protein expressions were compared

using the student's T-test.

3.7 Direct Immunofluorescence Assay

3.7.1 Concept

Direct immunofluorescent techniques utilize fluorophore-conjugated primary antibodies

to visualize where antigens of interest are present within tissue. The excitation and emission

spectra of the fluorophores are used to produce controlled fluorescence in the sample (see Error!

Reference source not found. for the spectra related to the Cy3 fluorophore used in this study).

A special filter set that allows the transmission of desired wavelengths within the peak of the



excitation spectra is installed to the microscope and is used to excite specifically the fluorophore

involved with measuring the protein of interest. The resulting emission is captured with the filter

set and the images are qualitatively or semiquantitatively analyzed.
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Figure 10. Excitation and emission spectra of Cy3 fluorophore (Invitrogen). Maximal excitation of Cy3
occurs at 550 nm, with peak emission at 570 nm. Cy3 visualization can be visualized with traditional TRITC
filter sets (nearly identical emission and excitation spectra).

3.7.2 Discussion ofAssay Choice

Immunofluorescence is a visual assay which can be used to determine where proteins

appear in the tissue spatially. This benefit allowed for the direct comparison of regenerate from

the silicone treatment group with the regenerate from the collagen treatment group. In this and

previous studies, the collagen device and the regenerated tissue are known to become

interconnected over the course of the study so it is impossible to mechanically separate the tube

from the sample (Harley 2002; Wong 2008). In the ELISA and immunoblot assay, the collagen

tube is left intact with the regenerate and included in the protein measurements. The inclusion of

the collagen tube in the other assays was of considerable concern with a SMA quantification

because an external scar which forms on the outside surface of all implants was still included in

the collagen treated samples but omitted from the silicone treated samples. This external source



of a SMA compromised the measurements in the immunoblot assays. Therefore,

immunofluorescence was used in two ways: to generate a preliminary estimate for the correction

factor for the a SMA immunoblot, and to semiquantitatively compare a SMA only within

collagen treated and silicone treated regenerate.

One caveat of the immunofluorescence assay is that the exudate that is included with the

samples analyzed in ELISA and immunoblotting is lost in the fixation and embedding process.

While this assay was not used in this study to quantify the TGF 3 proteins, any cytokines present

in the exudate would not have been measured by immunofluorescence.

3.7.3 Immunofluorescence Method

The samples used in the immunofluorescence study were sectioned in 6 pm slices using a

microtome and mounted in triplicates on microscope slides (Superfrost Gold Plus, Cat. No. 15-

188-48, Thermo Fisher Scientific, Inc.). Slides were air dried for an hour and placed on a slide

warmer for an additional hour before storage in a slide holder. When ready for immunostaining

(Appendix A.17), the slides were returned to the slide warmer for at least an additional hour.

The warmed slides were immediately deparaffinized using xylene and rehydrated with graded

ethanol solutions before a tap water wash. Slides were microwaved for ten minutes in a citrate-

based antigen unmasking solution (Cat. No. H-3300, Vector Laboratories, Inc., Burlingame, CA)

in order to expose epitope sites that may have become crosslinked in the fixation process. The

slides were allowed to cool for 20 minutes before three washes in PBS. The samples were

incubated overnight in Cy3 conjugated a SMA antibody (Cat. No. C6198, Sigma-Aldrich, St.

Louis, MO) at 40 C while stored in a humid chamber to prevent evaporation. Any unbound

antibody after overnight incubation was removed with three washes of PBS. To stain for nuclei,
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the samples were incubated with 200 ng/ml DAPI Nucleic Acid Stain (Cat. No. D1306,

Invitrogen, Carlsbad, CA) at room temperature for 10 minutes. The samples were washed with

PBS for a final three times and coverslipped with Shandon Immu-Mount (Cat. No. 9990402,

Thermo Fisher Scientific, Rockford, IL).

The slides were allowed to dry for an hour before imaging with the Olympus BX60

microscope. Slides were chosen from the proximal nerve trunk, interneural wound gap, and

distal nerve trunk. DAPI staining was visualized using the UV filter while Cy3 fluorescence was

visualized using the TRITC filter. Due to the limited field of view of the camera attachment,

images for each nerve cross section had to be stitched together using Adobe Photoshop.

3.7.4 Immunofluorescence Data Analysis

The immunofluorescent images offered a wealth of data pertaining to a SMA expression

in the wound site. For silicone treated wounds, the cross sections illustrated a SMA in the

regenerate expressed by contractile myofibroblasts and blood vessel pericytes. For collagen

treated wounds, the cross sections illustrated a SMA from three sources: scarring from the

external surface of the device surface, myofibroblasts contained within the collagen tube, and the

myofibroblasts and blood vessel pericytes from within the regenerate (Figure 11). In comparing

a SMA expression across treatment groups, the actual region of interest (ROI) was only the

nerve regenerate. Thus, the use of image analysis software was crucial in accurately assessing a

SMA content in the regenerating wound.



Figure 11. One 10x captured image of collagen treated wound cross section stained for a SMA (red). Multiple
10x images are stitched together to create image of entire nerve cross section. White lines delineate borders
between regions of the image. The background (region 1) is negative space on the slide containing no tissue.
Scar and blood vessel formation (region 2) on the outside surface of the collagen tube stains highly for a
SMA. The collagen tube (region 3) is still intact at 2 weeks and harbors some contractile cells expressing a
SMA. The regenerate (region 4) has some a SMA expression, with intense staining from blood vessels
(arrow).

The first objective, to produce a preliminary correction factor for the a SMA immunoblot

assay, required determination of a SMA expression from the regenerate as a percentage of the

expression from the total cross section. This was done in ImageJ by thresholding the images and

measuring the intensity of the a SMA expression in the total image. A ROI was defined around

the regenerate and the intensity from only the regenerate was measured. a SMA expression of

the regenerate was calculated as a percentage of total a SMA expression. A similar process was

followed using images from DAPI stained cross sections to determine the cellular content of the

regenerate as a percentage of the total cross section. In ImageJ, the images were thresholded for

nuclei and the 'Analyze Particles' function was used to count the number of nuclei in the entire

cross section. A ROI was defined around the regenerate and 'Analyze Particles' was used again

to count the number of nuclei only in the regenerate. This percentage was used to correct for the
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normalization factor in the a Tubulin data. Percentages of a SMA expression and cellular

content contributed by the regenerate alone were averaged across animals in the collagen tube

treatment group, and the process was repeated at various data points to determine a scaling factor

for the immunoblot a SMA data as a function of distance along the length of the nerve.

The second objective involved determining the protein expression within a ROI in the

nerve cross sections for the appropriate comparison of a SMA between collagen and silicone

treated samples. a SMA is a component of both myofibroblasts and pericytes in the regenerating

nerve, but the primary interest was to determine the amount of contractile capsule activity in the

early stage wound. Chamberlain et al. previously found a SMA expression as much as 10 to 15

cell layers in from the regenerate periphery in 30 to 60 week explants (1998a; 2000). Thus, a

ROI from the edge of the nerve regenerate to about -65 gm inwards was defined to include this

region previously observed to contain contractile cells (proposed myofibroblasts). Within this

region, images of the regenerate were quantified for intensity in the red channel as a function of

radial distance away from the edge. Using image analysis software, a border was defined along

the periphery of the regenerate. A program was run to sample the average intensity of pixels at

the edge and subsequently in concentric shells shrunk 5 pixels inwards for the next 100 pixels.

Based on the settings of the microscope and digital capture, this corresponded to the desired ROI

from 0 to -65 jim away from the edge. The average intensities from the ROI were summed and

then a mean was generated for and compared between treatment groups. For each animal, this

expression statistic was determined for five cross sections along the length of the nerve, and the

statistics were averaged for animals of the same treatment group. Order 2 polynomials were

used to create curve fits to describe protein expression versus location along nerve for silicone



and collagen treated wounds, and the areas underneath the curves were compared between

treatment groups.

3.7.5 Correction Factor Results

Using immunofluorescence intensity as a relative quantifier of protein expression within

regions of nerve cross sections, a SMA expression from nerves treated with collagen or silicone

tubes were divided as follows:

Percent contribution of a
Treatment Device Source SMA expression in nerve

cross sections (mean d SEM)
Silicone Regenerate 100%

Regenerate 5.7% + 2.3%

Collagen External to Regenerate
(Collagen Tube, Tube Outer 95% T 2.3%

Surface Scar)
Table 11. Percent contributions of a SMA expression from sources internal and external to regenerate tissue.

For all animals, percentages of a SMA from the regenerate and external to the regenerate tissue

were sampled in four cross sections along the nerve and averaged to give the percentages

pertaining to each treatment device. The difference in percent a SMA expression contributed by

the regenerate along the length of the nerve was not found to be statistically significant, and so

the mean percent across all cross sections was used to generate the numbers in Table 11.

Based on the number of DAPI stained nuclei counted internally and externally to the

regenerate tissue, percentages of cellular content were divided as follows:
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Percent contribution of
Treatment Device Source cellular content in nerve

cross sections (mean A: SEM)
Silicone Regenerate 100%

Regenerate 35.3% T 4.1%

External to RegenerateCollagen
(Collagen Tube, Tube Outer 64.7% T 4.1%

Surface Scar)
Table 12. Percent contributions of cellular content from sources internal and external to regenerate tissue.

Statistically significant differences were not found in cellular content as a function of

location along the nerve. One would expect there to be less cellular content in the regenerate as

the cross sections are taken from the center of the interneural wound gap. Statistical

insignificance was perhaps due to high animal-to-animal variation and may require sampling

from more animals for a more accurate correction factor. Because any difference found in the

percent cellular content as a function of location within the nerve was not statistically significant,

the percent cellular contents were averaged from all cross sections and used to generate the

numbers in Table 12.



Chapter 4: Results and Error Analysis

Protein expression levels in wounded nerve tissue treated with silicone or collagen tubes

were compared on a "whole wound" basis to determine overall differences in the entire tissue

and on a "per segment" basis to determine local differences in -2-4 mm regions of tissue. Recall

that in the ELISA and immunoblotting assays, the collagen treated wounds were digested with

the collagen device which could not be mechanically removed from the regenerate. For all

assays, wounds treated with silicone tube were removed from the silicone device. References to

the explanted tissue mass in ELISA refer to the regenerate only in the silicone treated group or

the regenerate and attached collagen tube in the collagen treated group. References to cellular

content in immunoblot refer to the amount of a Tubulin present in the regenerate only in the

silicone treated group or the regenerate and attached collagen tube in the collagen treated group.

Immunofluorescence was used to visually determine the boundary between the regenerate

and the collagen device, thus allowing for the direct comparison of regenerate only in both

treatment groups. A region of interest (ROI) was defined from the regenerate periphery to -65

pm radially inwards where presence of a contractile capsule was previously noted and also

observed in this study.



4.1 TGF pl Expression
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Figure 12. 14-day whole wound TGF crease expression Figure 13. 14-day whole wound TGF 31 expression
(mean + SEM) as determined by ELISA. Expression (mean + SEM) as determined by average immunoblot
was normalized by mass of the whole explanted intensity per unit area. Expression was normalized
tissure ment of TGF by cellular content.

Fourteen days after transection, the silicone treated peripheral nerve wounds

demonstrated a possible increase in whole wound TGF (31 expression over the collagen treated

wounds. Measurement by ELISA determined a 50% increase of TGF (31 levels on a mass

protein per mass of explanted tissue that was statistically significant (p=.0021). Immunoblot

measurement of TGF 131 normalized by cellular content similarly showed a 30% increase in total

TGF j31 expression in silicone treated wounds. However, the immunoblot result did not achieve

statistical significance.

Differences in normalized TGF 31 expression between the two treatment groups when

observed on a per segment basis were most prevalent at the proximal and distal stumps. At the

nerve trunks there was a possible 100% increase in TGF P31 levels in the silicone treated from the

collagen treated wounds, while in the center of the gap there was no difference. While ANOVA



indicated a significant difference at the proximal stump from ELISA measurements, no

significant differences were determined in any segment from the immunoblot data.
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Figure 14. 14-day TGF l1 expression (mean I SEM) on per segment basis as determined by ELISA.
Expression was normalized by mass of the explanted tissue segment.
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Segment Number

Segment 1 Segment 2 Segment 3 Segment 4 Segment 5

Collagen 1.11 ± 0.50 0.99 ± 0.46 1.19 ± 0.34 1.28 ± 0.36 1.48 ± 0.43
Treated
SiliconeSilicone 2.12 ± 0.69 1.73 ± 0.67 1.09 ± 0.48 2.19 ± 0.88 2.34 ± 1.48
Treated

Figure 15. 14-day TGF P1 expression (mean ± SEM) on per segment basis as determined by average
immunoblot intensity per unit area. Expression was normalized by cellular content.
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4.2 TGF 12 Expression
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Figure 16. 14 day whole wound TGF P2 expression (mean ± SEM) as determined by average immunoblot
intensity per unit area. Expression was normalized by cellular content.

Fourteen day sciatic nerve wounds treated with collagen and silicone devices showed no

statistically significant difference in TGF 02 expression when measured with immunoblot. Data

from the wound segments alone showed possibly higher TGF P2 expression in the silicone group

in the most proximal segments. However, this result was statistically insignificant.
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Segment Number

Segment 1 Segment 2 Segment 3 Segment 4 Segment 5

Collagen 0.56 ± 0.14 0.39 + 0.08 0.73 ± 0.26 0.61 ± 0.27 0.73 ± 0.32
Treated
SiliconeSilicone 1.09 ± 0.51 1.05 ± 0.54 0.66 L 0.26 0.97 ± 0.40 0.73 ± 0.27
Treated

Figure 17. 14-day TGF P2 expression (mean ± SEM) on per segment basis as determined by average
immunoblot intensity per unit area. Expression was normalized by cellular content.
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4.3 TGF P3 Expression
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Figure 18. 14-day whole wound TGF P3 expression (mean ± SEM) as determined by average immunoblot
intensity per unit area. Expression is normalized for cellular content.

Immunoblot assay showed three times the whole wound TGF P3 expression in the

collagen treatment group from the silicone treatment group (p=.002). This difference was

confirmed on a per segment basis. All five collagen treated segments had increased levels of

TGF 03 expression compared to the silicone treatment group, though statistical significance was

only confirmed in the first four segments.
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Segment Number

Segment 1 Segment 2 Segment 3 Segment 4 Segment 5

Collagen 2.26 ± 0.36 3.61 ± 0.62 3.19 ± 0.65 4.33 ± 1.00 2.91 ± 0.61
Treated
SiliconeSilicone 1.10 ± 0.30 0.92 ± 0.21 0.75 ± 0.17 0.99 ± 0.24 1.56 ± 0.60
Treated

Figure 19. 14-day TGF 13 expression (mean ± SEM) on per segment basis as determined by average
immunoblot intensity per unit area. Expression was normalized by cellular content.
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4.4 a SMA Expression
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Figure 20. 14-day whole wound a SMA expression (mean ± SEM) as determined by average immunoblot
intensity per unit area. Expression has been adjusted to reflect a SMA expression inside the regenerate only
with normalization by cellular content.

Recalling Section 3.7.5, expression of a SMA in the collagen tube induced regenerate

required correcting the immunoblot method for the tissue triage procedure that left the collagen

tube in contact with the regenerate. Based on analysis from immunofluorescent images taken

throughout different regions of the nerve, it was estimated that the immunofluorescent signal

from the regenerate accounted for 5.7% of the total a SMA expression and 35.3% of the total

cellular content in the collagen treated wound. This correction factor was applied to the

immunoblot data, and differences in a SMA present only in the regenerate were compared across

treatment groups. Whole wound a SMA expression was 440% greater in the in silicone

compared to collagen treated nerves (p=.0046). The significant difference in a SMA expression

was also observed on a per segment basis across all segments.
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Segment Number

Segment 1 Segment 2 Segment 3 Segment 4 Segment 5

Collagen 0.14 + 0.02 0.12 ± 0.02 0.18 ± 0.04 0.18 + 0.06 0.14 ± 0.02
Treated
Silicone 1.12 ± 0.33 0.89 ± 0.27 1.16 ± 0.36 1.31 ± 0.43 1.21 ± 0.47
Treated

Figure 21. 14-day a SMA expression (mean - SEM) on per segment basis as determined by average
immunoblot intensity per unit area. Expression has been adjusted to reflect a SMA expression inside the
regenerate only with normalization by cellular content.

The level of a SMA sampled in a region of interest (ROI) from the edge of the regenerate

to -65 glm radially inwards was used as a metric to determine the contribution of protein

expression at the regenerate periphery (Figure 22). From plots of intensity as a function of radial

distance from the edge, the first large magnitude gradient encountered from the edge, e.g. 0.5

intensity units/um, corresponded to the boundary of contractile cell layers previously observed

by Chamberlain et al. (1998, 2000). For cross sections from the silicone treatment group
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sampled in the proximal and distal nerve trunk, contractile cell layers were almost as large as the

entire radial distance assayed. Compared to the nerve stumps, silicone induced regenerate in the

gap had a smaller thickness contractile cell layer (-5-10 gtm) but more diffuse staining

throughout the cross section. Cross sections in the collagen treatment group consistently had 0-

10 p.m of staining on the regenerate periphery.
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Figure 22. a SMA expression in 14-day (a) silicone and (b) collagen treated peripheral nerve wounds. Cross
sections were taken 2.5 mm from the proximal end of the tube, and intensity measurements were taken from
the edge of the regenerate to -65 pm radially into the center of the cross section to capture a SMA expression
from circumferential contractile cell layers observed in silicone treated wounds by previous investigators.
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Distance from Proximal End of Tube (mm)

Immunofluorescence Intensity Units

x = 2.5 mm x = 4.5 mm x = 6.5 mm x = 12 mm x = 15 mm

Collagen 302.7 + 46.3 229.1 ± 23.5 176.0 ± 51.8 236.0 ± 33.0 356.2 + 45.1
Treated
SiliconeSrcone 829.1 + 252.1 611.3 + 132.0 368.5 ± 90.4 622.5 + 193.7 1011.2 + 252.4
Treated

Figure 23. 14-day a SMA expression (mean + SEM) for 5 locations sampled in nerve using
immunofluorescence intensity as a metric. Intensity data for cross sections were summed over a concentric
shell extending from the periphery to -65 pm toward the center of the regenerate and averaged across
treatment groups.

Immunofluorescent cross sectional analysis was conducted at five data points along the

length of the nerve to compare a SMA expression in the two treatment groups as a function of

distance. Silicone treated wounds were found to express two to three times the level of a SMA

as did the collagen treated wounds. The significant differences between treatment groups

occurred in the proximal (x=2.5 mm, p=0.024; 4.5mm, p=0.041) and distal (x=12 mm, p=0.04;
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15 mm, p=0.002) trunks, but not at the data point sampled in the intemeural wound gap (x=6.5

mm).

Best fit curve 2  Area under curve
(Intensity Units)

Collagen Treated 4.0423x2 - 66.174x + 442.1 90.995 10887

Silicone Treated 13.885x2 - 227.4x + 1314.8 0.973 4122
Table 13. Polynomial order 2 best fit curve to describe peripheral a SMA expression across the entire nerve.

The a SMA expression from the whole wound periphery (ROI evaluated across the entire

nerve length) was quantified by integrating the order 2 polynomial best fit curves to the intensity

data. In comparing the two treatment groups with this calculation, silicone treated wounds

showed a 164% increase in the whole wound periphery expression of a SMA from the collagen

treated wounds.



Chapter 5: Discussion

5.1 TGF pl Expression

The pro-fibrotic cytokine TGF 31 was measured in higher levels in silicone than collagen

tube treated wounds, but statistical difference could only be achieved through an enzyme-linked

immunosorbent assay (ELISA). ELISA indicated about a 50% increase of whole wound TGF

31 levels in the silicone treatment group compared to the collagen treatment group (p=.0021).

Though immunoblotting showed a similar 30% increase in TGF 31 in the silicone treatment

group, the data did not show a statistically significant difference between silicone and collagen

treated wounds.

There are a number of possibilities that may explain the apparent inconsistency between

and the ELISA and immunoblot data. Differences in assay results may be due to the sensitivity

of the antibody used. Immunoblotting was performed using a different antibody than those used

provided in the ELISA kit. In addition, immunoblotting is a semiquantitative technique to

compare relative amounts of protein between samples. The immunoblot assay produces more

variation than the ELISA method due to the operator-dependent nature of selecting protein

bands.

Wong found statistical difference in the levels of TGF 31 mRNA expression by day 7 but

not day 14 (2008). He observed about a 44% increase in mRNA expression that corresponds

well with the possible 30-50% increase in protein expression that may occur a few days later in

data obtained in this study. It is possible that the difference in TGF 31 expression between

treatment groups, if there is one, may have occurred maximally before day 14. If this is the case,

then the relative levels of TGF 11 between the silicone and collagen tube treated groups may

have been too small to be proven for 14-day data by the immunoblotting technique.



The comparison of wounded day 16 rat fetal skin and day 19 rat fetal skin by Soo et al.

(2003) serves as a benchmark for this study due to our interest to use differential cytokine

expression in early fetal wounds as a model for regeneration in the peripheral nerve. TGF pl

expression was found to be greater in magnitude and more prolonged for the late fetal scarring

wound than that of the early fetal wound that heals by regeneration. While I cannot definitively

state that there was a difference in TGF 31 expression between silicone and collagen treated

wounds on day 14 based on the data from the immunoblot assay, the research by Soo and

colleagues points out that the differences in TGF p1 expression are not only in magnitude but in

duration. The differential expression of TGF p1 expression in the regenerating versus

nonregenerating nerve may occur at an earlier time point.

Due to the difference in conclusion reached by the use of two assays, this study can only

conclude that the data suggest a 30-50% increase in TGF 31 protein expression in the silicone

treated wounds over collagen treated wounds by day 14. This suggested difference could be

explored in future work with immunofluorescence. However, it may be more useful to spend

more effort exploring TGF p1 protein levels in the nerve wounds between the day 7 and day 14

time points which may contain the maximal difference between TGF p1 expression.

5.2 TGF P2 Expression

No statistical difference in TGF P2 expression could be measured between the collagen

and silicone treated wounds 14 days post-operatively. This was consistent with Wong's data,

which did not find differences in TGF 02 expression until another week into the wound healing

process (2008). Soo et al. found an increase in TGF 02 expression in late fetal over early fetal

wounds in immunohistological determinations but not by RT-PCR techniques, which showed the
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reverse at 24 and 72 hours post injury (2003). The protein level increase at the late fetal stage

determined by immunohistochemistry was less than that observed for TGF 31. The investigators

hypothesized that the increase in TGF 32 they observed may be a result of inflammatory

infiltrate, and concluded that TGF 32 transcription may not be important for scar formation. In

another study by Broker et al., comparison of fetal to adult fibroblasts in TGF P2 expression

showed no difference (1992). My study therefore concurs with the above studies in TGF P2's

diminished role in regenerative wound healing.

5.3 TGF P3 Expression

Unlike the results for the other isoforms, a marked difference was found in TGF 03 levels

between day 14 collagen and silicone treated wounds. As quantified by immunoblot, collagen

treated wounds expressed three times the levels of TGF P3 than that of the silicone treated

wounds (p=.0026). This corresponds with the differential TGF 03 mRNA expression observed

by Wong which also showed three times the levels in collagen over silicone treated wounds

(2008). This result suggests a transcriptional and protein level difference in TGF 03 that may be

important at the two-week time point for regenerative wound healing.

TGF P3 has been implicated by other studies as having an anti-inflammatory role. This

observation was upheld by Soo et al., who similarly observed heightened and prolonged

expression of this particular isoform in early fetal skin wounds over late fetal skin wounds

(2003). This investigation is additional confirmation that TGF 03 expression has influence on

the determination of a regenerating wound.



5.4 a SMA Expression

Immunoblot and immunofluorescent techniques showed a large and significant increase

in day 14 a SMA expression in silicone treated versus collagen treated peripheral nerve wounds.

Immunoblot results gave an estimate of ten times the amount of a SMA in silicone treated

wounds than collagen treated wounds. This estimate was gathered by applying a preliminary

correction factor to the immunoblot data due to the external scar covering the collagen tube

surface that could not be removed from the samples assayed. The correction amounted to

considering only a SMA that accumulated around the regenerated nerve rather than including a

SMA that had accumulated around the still undegraded collagen device. A more accurate

correction factor can be determined in future work requiring more numerous sampling across the

nerve regenerate.

A measurement of a SMA expression in only the regenerate was determined using

immunofluorescence, in which the spatial distribution of the protein was mapped as a function of

distance from the nerve periphery. At a 14 day time point, significant increases in levels of a

SMA in silicone treated wounds occurred in cross sections taken at every location assayed along

the nerve wound except at the one data point taken in the interneural wound gap (x=6.5). The

largest increase in expression between the two treatment groups was about 170-180% and

occurred at the proximal and distal nerve trunks (p=.0243; p=.0021). At the nerve stump cross

sections, silicone treated wounds had a thick layer of very bright a SMA staining that was

sometimes as thick as 65 gm, while collagen treated nerve wounds showed occasional intense a

SMA staining that, when present, was only 5-10 gm thick. This amount of a SMA staining was

consistent in the collagen treated nerve wounds in cross sections taken along the length of the

nerve. A statistically significant difference could not be shown in the a SMA expression
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between treatment groups at the cross section taken from the interneural wound gap. There was

only a thin -400 gm diameter tissue regenerate that spanned the gap from the proximal to the

distal end of the silicone treated wound by two weeks post-operative from injury. The thin tissue

regenerate from the silicone treated wounds showed only -5-10 gm of intense a SMA staining at

the periphery, but a basal level of a SMA staining into the center of the regenerate, as expression

of a SMA is much more diffuse in the early stages of wound healing.

Consistent with Wong's (2008) and the data of Chamberlain et al. (1998b, 2000),

presence of a SMA in the collagen treated wounds was far less than that in the silicone treated

wounds. This study, which sampled nerves at a 14-day time point, adds to our understanding of

contractile cell presence at the early wound healing stage. The immunofluorescent staining used

in this investigation gave more insight on the spatial distribution of a SMA, which was valuable

in developing a metric that focused on the region of myofibroblast concentration.

Presence of myofibroblasts in both early fetal and adult wounds was observed in previous

wound healing studies (Rolfe et al., 2007). However, in the study by Rolfe and colleagues, fetal

dermal fibroblast (FDF) response to TGF 31 was shown to be much more rapid and short lived

than the response of adult dermal fibroblasts. Differentiated FDF also failed to produce

increased levels of ECM component deposition as do their adult counterparts. My study

concludes that nerve wounds treated by the regenerative collagen device do express some levels

of a SMA that correspond to blood vessels and an occasional, but small layer of contractile cells

at the periphery of the regenerate. The lower expression of a SMA at the periphery of the

collagen induced regenerate implies a smaller extent of myofibroblast activity than that present

in the contractile capsule formed around the regenerate induced by the silicone treatment.



Chapter 6: Summary

The rat model serves as a good basis for comparing regenerative and nonregenerative

wound healing outcomes in the adult. This study attempted to explain regenerative versus

nonregenerative healing in peripheral nerve through a proteomic analysis. The outcomes of

wound healing were observed in a rat model using a well defined defect involving complete

transection of the sciatic nerve. The nerve ends were bridged with a silicone or collagen

tubulation device, previously shown to have poor and good ability, respectively, in regenerating

nerve trunk across a 10 mm gap.

This study assayed the wounds of the two treatment groups for relative amounts of TGF

31, TGF 032, TGF P3, and a SMA, which are known to play important roles in wound healing,

especially with respect to the pressure cuff theory that points to myofibroblast activity as a

determinant for regenerative versus nonregenerative outcomes in peripheral nerve healing. The

peripheral nerve wounds from the collagen treatment group expressed upregulated levels of TGF

B3, lower a SMA levels, and possibly decreased levels of TGF pl compared to the silicone

treatment group. The proteomic trends observed between wounds treated with the collagen

regenerative device versus the silicone nonregenerative device are also observed between

wounds undergoing early fetal regeneration versus adult nonregenerative repair. Results from

this study concur with the use of early fetal regeneration as a model for induced adult

regeneration in the peripheral nerve.
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Appendix A: Protocols

A.1 5% Collagen Tube Fabrication Protocol
adapted from Harley, 2000

SUPPLIES
* 0.25 g Type I Collagen (Integra)
* 150 gL Glacial Acetic Acid (GAA, Mallinckrodt)
* 22 Gauge Needle (Cat. No. 309574, Becton Dickinson)
* 10 mL Syringes (Cat. No. 309604, Becton Dickinson)
* Female-female Luer Lock Assembly (Stainless steel Luer Lock tube fitting, female luer x

female luer, Cat. No. 5194k12, McMaster-Carr)
* Stainless Steel Wire (0.032" D., Cat. No. GWXX-320-30, Small Parts)
* Teflon Tubing, O.D. 0.056", I.D. 0.032" (PTFE Tubing, Cat. No. 06417-31, Cole-

Parmer)
* Teflon Tubing, O.D. 0.125", I.D. 0.065" (PTFE Tubing, Cat. No. 06407-42, Cole-

Parmer)
* Two Teflon and Aluminum Molds (see Figure 24 and
* Figure 25)

SOLUTIONS
* Acetic Acid, 3.0 M: 300 pL glacial acetic acid, 1.7 mL distilled water

EQUIPMENT
* Centrifuge (Heraeus Labofuge 400R)
* Lyophilizer (VirTis Genesis EL or LE)

PROCEDURE

PREPARATION
* Assemble mandrels using a stainless steel wire core surrounded by Teflon tubing (O.D.

0.056", I.D. 0.032"). The length of the mandrel should be several mm larger than the
length of the mold.

* Spacers, to be used at the ends of mandrels, are made out of Teflon tubing (O.D. 0.125",
I.D. 0.065") and are on the order of 5-10 mm long.

* Autoclave mandrels and spacers before use.
* Clean two Teflon and aluminum molds with acetic acid. Per the protocol to follow,

approximately 12 tubes (6 tubes per mold) can be made.

TUBE FABRICATION
* Fill two 15 mL Falcon tubes with approximately 5 mL of distilled water. Leave both

tubes uncapped and centrifuge at 4500 rpm for 10-15 minutes to degas.
* Draw 3.0 M acetic acid into 3 mL syringe with 22 gauge needle
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* Weigh 0.25 g Type I Collagen (Integra Life Sciences, San Diego, CA). Place collagen
into 10 mL syringe that has Parafilm covering luer-lock end. Add 4 mL degassed,
distilled water and mix thoroughly with forceps.

* Insert plunger into syringe and invert syringe, allowing collagen mixture to fall away
from the syringe tip. Remove Parafilm and mix collagen slurry by moving stopper up and
down. Purge air out from tip, bringing plunger up so that slurry comes up to the tip.

* Slowly inject 1 mL 3.0 M acetic acid into collagen, placing the needle from the 3 mL
syringe through the tip of the 10 mL syringe with collagen-water suspension. Add the 1
mL acetic acid slowly while mixing with needle tip and pulling back on the 10 mL
syringe plunger.

* Blend slurry well until a homogenous mixture is achieved. Attach 10 mL syringe with
collagen slurry to another 10 mL syringe with a female-female Luer Lock assembly and
mix by injecting collagen slurry from one syringe to another. Mix back and forth 10-15x,
until collagen fibers begin to hydrate and solution appears uniform.

* Try to make sure as much of the collagen slurry is in only one of the 10 mL syringes.
Remove empty syringe and Luer Lock fitting. Seal the tip of the full syringe with
multiple layers of Parafilm to ensure that the collagen does not escape during
centrifugation.

* Do not remove plunger. Let slurry mixture sit for 3 hours at room temperature to allow
for the collagen fibers to swell.

* After 3 hours, remove plunger, but keep Parafilm over syringe tip. Cut a small notch in
on the side of the black rubber material using a razor.

* Set lyophilizer to -400 C (it takes 2 1 hr for chamber to reach set temperature).
* Centrifuge the collagen slurry in the syringe in order to degas the collagen so that it

homogenizes without any macroscopic air bubbles. Place the syringe into a 50 mL
Falcon tube, using a moist, folded paper towel to brace the syringe along the central axis
of the conical tube.

* Mass the Falcon tube-syringe system and make the counterweight of the same mass using
a Falcon tube filled with water.

* Centrifuge the Falcon tubes at 4500 rpm (3940xG) at 250 C for 30 minutes. Check to
make sure that the syringe is still centrally aligned in the Falcon tube; if not, make the
appropriate adjustments. Return the Falcon tube-syringe system to the centrifuge and
spin at 4500 rpm (3940xG) at 250 C for 30 minutes.

* Take the molds and align the top and bottom. Close molds using screw mechanism or 4
c-clamps.

* Remove the syringe from the centrifuge. Slowly return the plunger to the syringe while
removing the parafilm seal.

* Slowly inject the centrifuged slurry (-0.25 mL per tube) into closed molds until slurry is
apparent on other side. Insert mandrel into slurry, rotating mandrel during insertion so as
to keep the mandrel centered and to maintain a uniform deposition of collagen throughout
the mold. Cap the free ends of the mandrel with the spacers after the mandrel is fully
inserted. Repeat step, filling as many holes possible of each mold.

* Place molds in lyophilizer for 1 hour. Depending on the shelf height, the molds will be
placed horizontally or vertically on the shelf. Be sure to note which orientation was used.



* After freezing, remove the molds from the lyophilizer and split them. Gently remove the
tubes using clean forceps and a razor. Keep the mandrels inside the tubes. Place tubes
with mandrels back into the lyophilizer (at -400 C).

* Pull vacuum in lyophilizer until both readouts are below 200 mTorr.
* Raise temperature to 00 C and leave overnight under vacuum in lyophilizer (17 hours).
* Raise temperature to 200 C and release vacuum.
* Create aluminum foil packet by tearing a large sheet of aluminum foil and folding it in

half once in one direction, and once in half in the other direction. The walls of the packet
should now be two sheets thick. For two of the three open edges, fold over the sheet
twice approximately 8 mm each time to create a durable closure. The open edge is for
deposition of the collagen tube. Using a lab marker, label the package with the following
information:

o Collagen I Nerve Tubes
o Tf= -400 C
o Investigator Name, Date of Fabrication

* Remove tubes (Figure 26 for final dimensions) with mandrels from lyophilizer and place
into aluminum foil packets. Close the open edge by folding it over twice. Store packets
in dessicator with DrieRite Absorbent (VWR International,
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A.2 Dehydrothermal Treatment (DHT) of Implant Devices
adapted from Harley, 2000

SUPPLIES
* Silicone tubing (ID: 3.1 mm, Helix Medical, LLC, Carpinteria, CA)
* Razor
* Phosphate buffered saline (PBS) (Cat. No. BM-220S, Boston BioProducts)
* Teflon sheet
* Ruler
* Razor
* 500 mL glass jar with lid
* Glass vials (Short Form Style with Phenolic Cap, Cat. No. 66011-063, VWR)

o 1 for each silicone device
* Lyophilized collagen tubes, contained within aluminum foil packet

EQUIPMENT
* Vacuum oven (Isotemp Model 201, Fisher Scientific)

PROCEDURE
DHT is performed on silicone and collagen tubes used for implantation. They do not have to be,
and usually are not, treated at the same time. Silicone tubes are treated 1-2 days before surgery
while collagen tubes should be treated immediately after lyophilization.

PREPARATION
* All metal instruments should be cleaned with 70% ethanol.
* The glass vials, jars, and lids should be autoclaved.
* For silicone tube DHT

o Prepare silicone tube implants in a clean environment by measuring 16 mm of
silicone tubing on a Teflon sheet. Cut with a razor. Flush each segment twice
with PBS and place in individual glass vials without the cap on.

* For collagen tube DHT
o Obtain collagen tubes contained inside aluminum foil packet immediately after

lyophilization step or with little time spent in storage with desiccant (do not store
for more than 24 hours prior to DHT). Open the top edge of the foil packet.

* Place vials and caps or packet in the vacuum oven at the established set temperature.

DHT PROTOCOL
Set Temperature Exposure Time
120 oC 48 hours

* Turn purge valve off and vacuum valve on. Flip the switch on the vacuum to turn it on.
The vacuum oven should reach a final pressure of approximately -29.7 mmHg.



* At the end of the exposure period, turn off the vacuum and vent the chamber. Open the
vacuum door and immediately seal the vials or aluminum foil packet. The tubes hould
only be handled under sterile conditions from now on.

* Place the silicone tube vials in the 500 mL glass jar and close the lid.
* Store the tube in a dessicator with DrieRite Absorbent (VWR International, Inc., San

Diego, California). Crosslinked matrices can remain for a few months in a dessicator
prior to testing or use.



A.3 Sterile Procedure and Implant Assembly for Surgery Preparation
adapted from Chamberlain, 1998, Spilker, 2000; Harley, 2002

SUPPLIES
* Jewelers Forceps
* Regular Forceps (2)
* Large Forceps
* Surgical Blade Holder
* Needle Holder

PROCEDURE
To be carried out 1-2 days before implantation

IMPLANTATION DEVICES
* Dehydrothermally Treat (DHT) tubes (Appendix A.2)

o Silicone tubes in individual glass vials.
o Collagen tubes in packets

* Bring the DHT crosslinked collagen tubes to a sterile biohood. Using a Teflon sheet,
ruler, forceps, and razor that have been sprayed with 70% ethanol, cut the collagen tubes
into 16 mm segments. Place each segment into an individual aluminum foil packet.
Close the packets.

* Store all implant devices in dessicator until transportation to VA Medical Center.

SURGICAL TOOLKIT
* Autoclave surgical instruments in autoclave bags.

; ~i__~i ~_1_1_____( _~____ ~__ _____ ____~ ~~___~__ ~_j~r__ ___l _^___lljl_~__ ^___ ~ili-(-~ .-~i I 0- ~n1111___~~______11111 __._._._nir-__



A.4 Surgical Protocol
Chamberlain, 1998; Spilker, 2000; Harley, 2002

SUPPLIES

* Order animals: Adult, female Lewis rats 150 - 200 g, from Charles River Laboratories.
Animals must arrive at least one week in advance of surgery to reduce the stress placed
on the animal due to travel.

* Sterilize the necessary items:

Metal Bowl
Gauze
Surgical Blade Holder
Microneedle Holder
Microscissors
Jewelers Forceps (2)
Large Forceps

Large Scissors
Surgical (Tenotomy) Scissors
Paper Clip Retractors (2)
Forceps (2)
Needle Holder
Animal Skin Staples
Wooden Rods (cotton swabs)

* Ready other sterile items:

Table Covering Pen
Scalpel Blades (4 #15 blade, 1 #11 blade) 10-0 Sutures
Bottle of PBS 4-0 Sutures
Iodine Sponge 1 mL Syringes
Draping
Implants
Bottle of Sodium Pentobarbital (Nembutal), 50 mg/ml
Small Piece of Wood (e.g. from tongue depressor)

* Ready other non-sterile items:

Surgical Board
Rubber Bands (4)
Ear Tagging Tool

Numbered Ear Tags
Microsurgery Glasses (Loops)
Hair Clippers

PROCEDURE

* Weigh animal on an approximately sized balance. Record the weight and determine
anesthetic dosage based on the pre-operative weight.

* Anesthetize animal with injection of sodium pentobarbital (50 mg of solution per kg of
animal). Allow 10-15 minutes for anesthesia to take effect. Each animal reacts
differently to the anesthetic and in some cases, more time may be required.

* Meanwhile, arrange the surgical area so that the table is at a comfortable level for the
surgeon, and the tools are conveniently located.

* The surgeon should be sterilely dressed in scrub shirt and pants, hat and mask.



* When ready, shave the animal using the animal hair clippers from the base of the tail up
to the middle of the back. The leg receiving the prosthesis should be shaved carefully
and completely.

* Place the animal on the surgical board in the prone position and secure the fore and hind
limbs to the board using rubber bands. The hind legs should be in 300 abduction. Place a
piece of gauze under the appropriate thigh to elevate the leg slightly.

* Connect the animal to 02 mask for the duration of the surgical procedure.
* Clean the shaved portion of the animal vigorously with the iodine sponge to disinfect the

area. At this point, the surgeon should put on the sterile gloves and remain sterile for the
rest of the procedure. Cut a hole in the sterile draping small enough so that only the leg is
exposed. Place the draping over the animal.

* Using the # 15 scalpel, make a 4 cm incision along the leg of the animal. Separate the
skin from the muscle along the incision by cutting through the connective tissue with the
surgical scissors.

* Using the surgical scissors, separate the muscles until the sciatic nerve is visible.
Carefully cut back the muscle along the skin incision line exposing the sciatic nerve.

* Place the paper clip retractors inside the muscle to separate the wound edges.
Anesthetize the nerve by placing a few drops of Lidocaine directly on the area. Cut away
the fascia surrounding the sciatic nerve carefully so that the nerve is free from constraint.

* Place the sterile wood piece underneath the nerve and carefully transect the nerve
midway between the proximal nerve trunk and the distral bifurcation using the scalpel.

* Measure the prosthesis and make a mark on the nerve stumps 3 mm from each end. If
necessary, trim prosthesis to appropriate length using microscissors.

* Place the tube in the gap and insert the proximal nerve stump 3 mm into the tube end, as
marked. Secure the nerve in place by using two 10-0 sutures which travel through the
epineurium and then through the tube. Inject enough sterile PBS into proximal end of
prosthesis to fill the device using the 1 cc syringe. Tie the sutures with four single knots.
Insert the distal nerve end 3 mm into the other end of the tube and secure in the same
manner.

* Remove the paper clip retractors and close the muscle layer using three 4-0 sutures.
Close the skin using skin staples.

* Place the animals on heating pads with 02 masks and monitor until they are mobile.
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A.5 Post-Operative Care and Supervision Protocol
adapted from Spilker, 2000; Harley, 2002

SUPPLIES
* Ketofen, 0.15 mg/mL
* Cefazolin, 100 mg/mL
* 1 mL TB Syringes

PROCEDURE

* Monitor rats immediately following surgery. Analgesic is to be started immediately
following surgery while the rat is still under anesthesia. Inject 0.1 mL of 0.15 mg/mL
Ketofen and 0.1 mL of 100 mg/mL Cefazolin subcutaneously every 24 hours for the next
72 hours. For hydration, make a one-time injection of 1 mL sterile Lactated Ringer's
solution immediately following surgery.

* Place rats into individual cages following surgery. Place food onto floor of cage for the
rat immediately following surgery.

* Continue to monitor eating and drinking and general condition of animals.



A.6 Animal Sacrifice
Soller, 2007

SUPPLIES
. Sterile Surgical Equipment

o Surgery Board
o #15 Scalpel Blade
o Forceps

* Tissue marker

EQUIPMENT
* Carbon dioxide chamber
* Camera

PROCEDURE

* Sacrifice animals by placing in carbon dioxide chamber for 3-5 minutes.
* Open the original wound with a #15 scalpel blade. The wound can be located by

identifying the dermal scar or skin staples.
* Open the fascia and muscle to locate the tube implant and adjacent nerve stumps.
* Photograph the experimental wound space in situ prior to removing the implant. Note

connective tissue response.
* Remove the entire tube implant as well as at least 5 mm of proximal and distal nerve

tissue. Mark the proximal stump with the tissue marker.
* Photograph the explant on the sterile surgery board to capture the gross morphology.



A.7 Optimal Cutting Temperature (OCT) Embedded Tissue Processing Protocol
adapted from Soller, 2007

SUPPLIES
* Insulated Container with liquid nitrogen
* Rectangular R-40 Peel-A-Way@ Embedding Molds (PolySciences, Inc., Warrington, PA)
* Optimal Cutting Temperature (OCT) Embedding medium
* Tissue marker
* Freezer packs
* Portable Cooler

PROCEDURE

TISSUE EMBEDDING
* Fill the bottom of the Rectangular Embedding mold with OCT.
* Carefully place explant (nerve stumps + prosthesis) on top of OCT layer as flatly as

possible. Maintain sample orientation by labeling the side of the mold that is closest to
the proximal nerve stump.

* Slowly cover the explant with OCT until the mold is mostly filled and the sample is
completely covered. Mold dimensions are 22mm wide x 40mm long x 20mm deep.

* Using forceps, carefully lower mold into liquid nitrogen and allow the OCT to freeze.
Do not completely immerse the mold to avoid quenching. Wait until freezing is complete
before moving mold to cooler filled with freezer packs.

* Store OCT-embedded samples in their molds in a -800C freezer for future analysis.



A.8 Formalin-Fixed Paraffin-Embedded (FFPE) Tissue Processing Protocol
adapted from Chamberlain, 1998

Materials
* Specimen Containers (Cat. No. 17000, Kendall)
* TRUFLOW Tissue Cassettes (Cat. No. 15-200-403E, Fisher Scientific)
* Biopsy Foam Pads (Cat. No. 22038221, Fisher Scientific)
* Microscope Slides (Superfrost Gold Plus, 15-188-48, Fisher Scientific)
* Monobasic Sodium Phosphate NaHPO4 (Sigma)
* Dibasic Sodium Phosphate Na2HPO4 (Cat. No. S-0876, Sigma)
* Glutaraldehyde, EM Grade, 25% (Cat. No. 01909-10, Polysciences)
* 10% Buffered Formalin Phosphate (Cat. No. SF 100-4, Fisher Scientific)
* Ethyl Alcohol EtOH (Histoprep)
* Xylene (Histoprep)
* Paraffin (Cat. No. 23-021-401, Fisher Scientific)

Solutions
* Stock A: .04175 g Na2HPO4, .22375 g Na2HPO4, 240 mL distilled water, 10 mL 25%

glutaraldehyde
* Stock B: 250 mL 10% formalin phosphate, .6125 g Na2HPO 4
* Yannoff's fixative = 1:1 mixture of Stock A:Stock B
* EtOH, 70%, 80%, 90%, 95%

Equipment
* Tissue Processor (TP1020, Leica)
* Embedding Center (Shandon Histocentre 2, Thermo Fisher Scientific, Inc.)

TISSUE FIXATION
* Explant the sciatic nerve from sacrificed animal and place tissue into individual specimen

containers with 20 mL of Yanoffs fixative for 24 hours at 40 C. Label each specimen
container lid with the animal number information.

* Transfer tissue into individual specimen containers with 20 mL of 10% neutral buffered
formalin solution for 24 hours at 40 C. Reuse container lids with animal information.

* Remove tissue from formalin and rinse in 70% EtOH.
* Photograph the nerve to capture the gross morphology of the tissue.
* Tissue can be stored in individual specimen containers with 20 mL of 70% EtOH until

ready for paraffin embedding. Reuse container lids with animal information.

PARAFFIN EMBEDDING
* Put nerves in tissue cassettes, sandwiched by two biopsy foam pads, and label the

cassettes with sample information, date, and investigator name in pencil. Keep the tissue
cassettes in 70% EtOH.



* Dehydrate and paraffinize
the following program:

nerves by placing the cassettes into the tissue processor with

Duration
Reagent Vacuum Duration Temperature

EtOH, 70% No 10 RT

EtOH, 80% No 90 RT

EtOH, 95% No 90 RT

EtOH, 95% No 90 RT

EtOH, 100% No 90 RT

EtOH, 100% No 90 RT

EtOH, 100% Yes 90 RT

Xylene No 90 RT

Xylene No 90 RT

Xylene No 90 RT

Paraffin Yes 180 580C

Paraffin Yes 180 580C
Table 14. Tissue processor settings for paraffin embedding

* Remove cassettes from tissue processor and place them in warm paraffin in paraffin
machine.

* Remove tissues from cassettes and section tissue in five 3-4 mm segments (record stump
location and lengths of segments).

* Place segment distal end down in embedding mold such that cross-sectional sections will
be later made with the microtome. Embed segment in paraffin. On top of the warm
paraffin, quickly add the cassette with the sample information written on it. Add more
warm paraffin on top of the cassette so that it will be attached to the sample.

* Cool embedded segment on cold plate for an hour before moving to -200 C freezer.
* After at least 24 hours, pop the paraffin-embedded sample from the mold. Remove any

excess paraffin from the cassette and return to -20 0 C freezer.

SECTIONING
* Section paraffin embedded sample with a microtome at 6um slices. Make a ribbon of

several sections.
* Place ribbon of sections on surface of water bath. Separate sections in duplicates or

triplicates. Position microscope slide underneath the sections and retrieve the sections
using a pencil as a guide.

* Shake off excess water from the microscope slide. Let air dry for 1 hour.
* Transfer slide to slide warmer for 1 hour. Store in slide box.



A.9 JB-4 Embedding, Staining, and Imaging for Pore Analysis
adapted from Freyman, 2001; O'Brien, Harley et al., 2004; O'Brien, Harley et al., 2005

SUPPLIES
* JB-4 A monomer solution (Cat. No. 0226A-800, Polysciences)
* JB-4 A catalyst, (Benzoyl Peroxide, plasticized, Cat. No. 02618-12, Polysciences)
* JB-4 B embedding solution (Cat. No. 0226B-30, Polysciences)
* Ethyl alcohol EtOH (PHARMCO-AAPER)
* Ammonium Hydroxide NH3 (aq) (Cat. No. 30501, Fluka)
* Microscope Slides (Superfrost Plus White, Cat. No. 22-034-979, Thermo Fisher

Scientific)
* Aniline Blue (Cat. No. A-967, Thermo Fisher Scientific)
* Glacial Acetic Acid (Cat. No. A A507-500, Thermo Fisher Scientific)
* Cytoseal 60 (Cat. No. 18006, Electron Microscopy Sciences)
* Cover slips (Fisherfinest Premium Cover Glasses, Cat. No. 12-548-5M, Thermo Fisher

Scientific)

SOLUTIONS
* Infiltration Solution: 0.3125 g of catalyst dissolved in 25 mL JB-4 solution A.
* Equilibration Solution: 50:50 solution of infiltration solution and 100% ethanol
* Embedding Solution: 1 mL of JB-4 B embedding solution dissolved in 25 mL freshly

made infiltration solution
* NH3 (aq), 10% (v/v): 10 mL ammonium hydroxide, 90 mL distilled water
* EtOH, 95% (v/v)
* Aniline Blue: 2.5 g aniline blue, 2 mL glacial acetic acid, 100 mL distilled water
* Acetic Acid, 1 % (v/v): 1 mL acetic acid, 99 mL distilled water

EQUIPMENT
* Microtome (Shandon Finesse ME, Thermo Fisher Scientific)
* Light Microscope (Olympus BX5 1) with Camera (Olympus U-CMAD3)
* Rotator (VWR)

PROCEDURE
For each change of solution, collagen tubes are transferred in new 1.5 mL eppendorf tubes filled
with solution.

DEHYDRATION AND INFILTRATION
* DHT collagen tubes are dehydrated by rotation in 100% alcohol overnight at 4C.
* Samples are equilibrated for 12 hours at 40 C while rotating in a solution 50%

ethanol/50% catalyzed JB-4 solution A.
* Infiltrate tubes in 100% catalyzed JB-4 solution A by rotation for 3 days at 40 C. Change

solution every 12 hours.

EMBEDDING
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* Prepare the plastic molds by placing over an icepack in fumehood. Pipet about 1.5 to 2
mL of embedding solution into plastic molds.

o Place samples in appropriate orientation in plastic molds. Ensure that sample
orientation is maintained.

o Solution begins to harden in approximately 30 minutes.
o After the JB-4 mixture becomes viscous enough that the samples do not float,

place labeled metal or plastic block holders onto each well and place the plastic
mold tray in a refrigerator (4'C) and wait overnight.

* Pop the blocks from the mold. Let the samples dry at room temperature for 1 day

SECTIONING
* Section embedded tube very slowly with a microtome at 6um slices.
* Place a drop of 10% ammonium hydroxide where the section is to put on the microscope

slide. Position the section on top of the drop. More than one section can fit per
microscope slide.

* When the slide is done, let dry on a slide warmer for 30 minutes.
* Store overnight in slide holder before staining with aniline blue.

ANILINE BLUE STAINING
* Dip in aniline blue solution for 2 min
* Place in 1% acetic acid solution for 1 min.
* Dip 5-10x in 95% EtOH until most of background staining goes away.

100% EtOH.
* Mount with Cytoseal 60 and coverslip.
* Dry in hood for 1 hour before imaging with light microscope.

Dip 5-10x in

IMAGING
* Bring stained slides to Olympus BX51 microscope (VA Medical Center, D1-147) and

locate sections with minimal air bubbles, contaminants, etc.
* Digitally capture the sections using the camera connected to the computer with

PictureFrame software. With gain at 4.9102 and target intensity at 75%, click on "Full
Image Find Exposure" button. Set correct scale under configurations. Take images at
4x, 10x, and 20x magnifications using "Snap" button.

o O1x images were used in linear intercept analysis of collagen tube cross-sectional
porosity.
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A.10 Linear Intercept Method for Pore Size Analysis
adapted from Harley, 2002; Freyman, 2001

SOFTWARE
* Adobe Photoshop
* Scion Image
* Microsoft Excel

PROCEDURE

IMAGE EDITING
* Open image in Adobe Photoshop. Select Image>Adjustments>Threshold. Change

threshold values until optimal image of collagen struts is visible. Clean up any remaining
spots using eraser tool.

* Change image size to 640x480. Save the image as an edited .tif file.

PORE ANALYSIS
* Open edited image in Scion Image. Go to Special>Load Macros and open "pore

characterization macros.txt" (code to follow).
* Set the scale for the analysis using Analyze>Set Scale. The scale is determined as

follows when taking the images with the Olympus BX51 (VA Medical Center, D1-147)
and having reduced the image size to 640x480:

o 4X: 214 px/mm
o 10X: 535 px/mm
o 20X: 1070 px/mm
o 40X: 2140 px/mm

* Select an area of the image to be analyzed using the oval drawing tool. Try to get as
much of tube enclosed within the curve.

* Go to Special > Linear Intercept. This calculates the distance between the pore walls
along lines at various angles emanating from the center of the selected region. Next, run
Special > Plot Intercepts. This macro will plot the average pore radii into a best-fit ellipse
and will calculate linear intercept coefficients Co, C1, and C2.

* Transfer Co, C1, and C2 data to an Excel spreadsheet. Calculate the minor (a) and major
(b) axes of the ellipse using the following equations:

1
a=

b=
co c + cV +c -

* Calculate the average pore diameter using the following equation. The two scaling factors
are for a scaling factor associated with the analysis (1.5") and to change from pore radius
to pore diameter (2*):
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Pore Diameter = 1.5 2 - a 2

2

ASSOCIATED CODE
Codes contained inside pore characterization macros.txt
macro 'Linear Draw'
{This macro is used for testing different line drawing routines for use
with the macro 'Linear Intercept'}
var

left, top, width, height,MinDim,nx,ny,i,j,k:integer;
ThetaStep,NSteps,PI,xl,x2,yl,y2,dy,dx:real;

Theta,valx,valy,plength,scale,AspectRatio:real;
IntLength,LineSum:real;

Intercepts :integer;
switch, indicator:boolean;
unit: string;

begin
GetRoi(left,top,width,height);
if width=0 then begin

PutMessage('Selection required.');
exit;

end;
if width<height then MinDim:=width

else MinDim:=height;
PI:=3.141592654;
GetScale(scale,unit,AspectRatio);
NSteps:=GetNumber('Enter theta steps between 0 and 90 deg.',3,0);
ThetaStep:=PI/(2*NSteps);
for j:=0 to 2*NSteps-1 do begin

xl:=left;
yl:=top;

Theta:=j*ThetaStep;
nx:=5*sin(Theta)*width/height;
ny:=5*abs (cos(Theta));
for i:=0 to nx do begin

if Theta=0 then begin
xl:=left;
x2:=xl+width;

end else begin
xl:=left+(width*i/(nx+l))+width/(2*(nx+l));
x2:=xl+(height*cos(Theta)/sin(Theta));

end;
y2:=top+height;

if x2>=left+width then begin
x2:=left+width;
y2:=yl+(x2-xl)*sin(Theta)/cos(Theta);

end else if x2<left then begin
x2:=left;

if Theta>PI/2 then y2:=yl+(x2-
xl)*sin(Theta)/cos(Theta);

end;
{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-
xl)+sqr((y2-yl)/AspectRatio));
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valx: =xl;
valy:=yl;

dx:=(x2-xl)/plength;
dy:= (y 2 -yl)/plength;
switch: =true;
if plength>=MinDim then begin

for k:=0 to plength do
PutPixel(xl+k*dx,yl+k*dy,255);

end;
end;
for i:=l to ny do begin

if Theta<=PI/2 then begin
xl:=left;
x2:=left+width

end else begin
xl:=left+width;
x2:=left;

end;
yl:=top+height*i/(ny+l);
y2:=yl+(width*sin(Theta)/abs(cos(Theta)));

if y2>top+height then begin
y2:=top+height;
x2:=xl+((y2-yl)*cos(Theta)/sin(Theta));

end;
{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-
xl)+sqr((y2-yl)/AspectRatio));

valx:=xl;
valy:=yl;

dx:=(x2-xl)/plength;
dy:=(y2-yl)/plength;
switch:=true;
if plength>=MinDim then begin

for k:=O to plength do
PutPixel(xl+k*dx,yl+k*dy,255);

end; {if}
end; {i}

end; {j}
end;

macro 'Linear Intercept'
{This macro measures the linear intercept distance over a giver ROI
at intervals of angle}
var

left, top, width, height,MinDim, nx,ny,i,j,k:integer;
ThetaStep,NSteps,PI,xl,x2,yl,y2,dy,dx:real;

Theta,valx,valy,plength,scale,AspectRatio:real;
IntLength,LineSum,dummy:real;

Intercepts :integer;
switch, indicator:boolean;
unit:string;

begin
SetOptions('Userl;User2');
GetRoi(left,top,width,height);
if width=0 then begin
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PutMessage('Selection required.');
exit;

end;
if width<height then MinDim:=width

else MinDim:=height;
PI:=3.141592654;
GetScale(scale,unit,AspectRatio);
NSteps:=18;{GetNumber('Enter # steps between 0 and 90 deg.',3,0);}

ThetaStep:=PI/(2*NSteps);

{block out next line when doing cumulative measurements}

SetCounter(2*NSteps);
SetUserlLabel('Theta(rad)');
SetUser2Label('Lxl0^3');
for j:=0 to 2*NSteps-1 do begin

LineSum:=0;
Intercepts :=0;
xl:=left;
yl:=top;

Theta:=j*ThetaStep;
nx:=10*sin(Theta)*width/height;
ny:=10*abs(cos(Theta));
for i:=0 to nx do begin

if Theta=0 then begin
xl:=left;
x2:=xl+width;

end else begin
xl:=left+(width*i/(nx+l))+width/(2*(nx+l));
x2:=xl+(height*cos(Theta)/sin(Theta));

end;
y2:=top+height;

if x2>=left+width then begin

x2:=left+width;
y2:=yl+(x2-xl)*sin(Theta)/cos(Theta);

end else if x2<left then begin
x2:=left;

if Theta>PI/2 then y2:=yl+(x2-

xl)*sin(Theta)/cos(Theta);
end;

{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-
xl)+sqr((y2-yl)/AspectRatio));

valx:=xl;
valy:=yl;

dx:=(x2-xl)/plength;
dy:= (y2-yl)/plength;
switch:=true;
if plength>=MinDim then begin
LineSum:=LineSum+(plength/scale);

for k:=0 to plength do begin

if GetPixel(xl+k*dx,yl+k*dy)>0
then indicator:=true

else indicator:=false;
if (switch=true) and (indicator=true) then begin

Intercepts :=Intercepts+l;
switch:=false;
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end;
if (indicator=false) then switch:=true;

end;
end;

end;
for i:=l to ny do begin

if Theta<=PI/2 then begin
xl:=left;
x2:=left+width

end else begin
xl:=left+width;
x2:=left;

end;
yl:=top+height*i/(ny+1);
y2:=yl+(width*sin(Theta)/abs(cos(Theta)));

if y2>top+height then begin
y2:=top+height;
x2:=xl+((y2-yl)*cos(Theta)/sin(Theta));

end;
{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-
xl)+sqr((y2-yl)/AspectRatio));

valx:=xl;
valy:=yl;

dx:=(x2-xl)/plength;
dy:=(y2-yl)/plength;
switch :=true;
if plength>=MinDim then begin
LineSum:=LineSum+(plength/scale);

for k:=O to plength do begin
if GetPixel(xl+k*dx,yl+k*dy)>0

then indicator:=true
else indicator:=false;

if (switch=true) and (indicator=true) then begin
Intercepts :=Intercepts+l;
switch:=false;

end;
if (indicator=false) then switch:=true;

end;
end;

end; {i}
IntLength:=LineSum/Intercepts;

dummy:=rUser2[j+l];
rUserl[j+l]:=180*Theta/PI;

{to do cumulative measurements, type in 'dummy+ before Intlength in the next
line}

rUser2[j+l]:=IntLength*1000;
end; {j}
ShowResults;

end;

macro 'Linear Intercept +'
{This macro measures the linear intercept distance over a giver ROI
at intervals of angle}
var
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left,top,width,height,MinDim,nx,ny,i,j,k:integer;
ThetaStep,NSteps,PI,xl,x2,yl,y2,dy,dx:real;

Theta,valx,valy,plength,scale,AspectRatio:real;
IntLength,LineSum,dummy:real;

Intercepts:integer;
switch, indicator:boolean;
unit: string;

begin
SetOptions('Userl;User2');
GetRoi(left,top,width,height);
if width=0 then begin

PutMessage('Selection required.');
exit;

end;
if width<height then MinDim:=width

else MinDim:=height;
PI:=3.141592654;

GetScale(scale,unit,AspectRatio);
NSteps:=18;{GetNumber('Enter # steps between 0 and 90 deg.',3,0);}

ThetaStep:=PI/(2*NSteps);

{block out next line when doing cumulative measurements)

{SetCounter(2*NSteps) ;
SetUserlLabel('Theta(rad)');
SetUser2Label('Lx10^3');

for j:=0 to 2*NSteps-1 do begin

LineSum:=0;
Intercepts :=0;
xl:=left;
yl:=top;

Theta:=j*ThetaStep;
nx:=10*sin(Theta)*width/height;
ny:=10*abs(cos(Theta));
for i:=0 to nx do begin

if Theta=0 then begin
xl:=left;
x2:=xl+width;

end else begin
xl:=left+(width*i/(nx+l))+width/(2*(nx+l));
x2:=xl+(height*cos(Theta)/sin(Theta));

end;
y2:=top+height;

if x2>=left+width then begin

x2:=left+width;
y2:=yl+(x2-xl)*sin(Theta)/cos(Theta);

end else if x2<left then begin
x2:=left;
if Theta>PI/2 then y2:=yl+(x2-

xl)*sin(Theta)/cos(Theta);
end;

{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-

xl)+sqr((y2-yl)/AspectRatio));
valx:=xl;

valy:=yl;

dx:=(x2-xl)/plength;
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dy:=(y2-yl)/plength;
switch :=true;
if plength>=MinDim then begin
LineSum:=LineSum+(plength/scale);

for k:=O to plength do begin
if GetPixel(xl+k*dx,yl+k*dy)>0

then indicator:=true
else indicator:=false;

if (switch=true) and (indicator=true) then begin
Intercepts :=Intercepts+l;
switch:=false;

end;
if (indicator=false) then switch:=true;

end;
end;

end;
for i:=l to ny do begin

if Theta<=PI/2 then begin
xl:=left;
x2:=left+width

end else begin
xl:=left+width;
x2:=left;

end;
yl:=top+height*i/(ny+l);
y2 :=yl+(width*sin(Theta)/abs(cos(Theta)));

if y2>top+height then begin
y2:=top+height;
x2:=xl+((y2-yl)*cos(Theta)/sin(Theta));

end;
{plength is the length of the line to be drawn in pixels}

plength:=sqrt(sqr(x2-
xl)+sqr((y2-yl)/AspectRatio));

valx:=xl;
valy:=yl;

dx:=(x2-xl)/plength;
dy:= (y2-yl)/plength;
switch:=true;
if plength>=MinDim then begin
LineSum:=LineSum+(plength/scale);

for k:=0 to plength do begin
if GetPixel(xl+k*dx,yl+k*dy)>0

then indicator:=true
else indicator:=false;

if (switch=true) and (indicator=true) then begin
Intercepts :=Intercepts+l;
switch:=false;

end;
if (indicator=false) then switch:=true;

end;
end;

end; {i}
IntLength:=LineSum/Intercepts;

dummy:=rUser2 [j+l] ;
rUserl[j+l]:=180*Theta/PI;
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{to do cumulative measurements, type in 'dummy+ before Intlength in the next

line}

rUser2[j+1] :=dummy+IntLength*1000;
end; {j}
ShowResults;

end;

Macro 'Plot Intercepts'
{This macro plots the linear intercept distance as a function of angle

in cylindrical coordinates
It then finds the best-fit ellipse to a set of linear intercept distance vs.

angle data
using multiple linear regression of the equation Y=CO+Cl*X+C2*Z, where

Y=1/L^2 , where L is one half the linear intercept distance at Theta

X=cosine(2*Theta), Z=sine(2*Theta)
CO=(Mii+Mjj)/2 , C1=(Mii-Mjj)/2 , C2=Mij.
The objective is to solve for M11, Mjj, and Mij

The best-fit ellipse it then plotted on top of the linear intercept

measurements}

var

left,top,width,height,XO,YO,X1,Yl,i,n:integer;
pscale,aspectRatio,dxl,dx2,dyl,dy2,maxdim:real;
unit:string;
sumX,sumY,sumZ,sumXZ,sumXY,sumYZ,sumZsqr,sumXsqr:real;
CO,C1,C2,Mii,Mjj,Mij,Y,X,Z,PI,Thetal,Theta2,Ll,L2:real;

begin
PI:=3.141592654;

SaveState;
SetForegroundColor(255);
SetBackgroundColor(0);
width:=400;
height:=400;
maxdim:=0;
for i:=l to rCount do begin

if rUser2[i]>maxdim then maxdim:=rUser2[i];
end;
pscale:=.8*(width+height)/(2*maxdim);
SetNewSize(width,height);
MakeNewWindow('Linear Intercepts vs. Theta');
SetLineWidth ();
XO:=(width/2);
YO:=(height/2);
MakeLineROI(0,YO,width,YO);
Fill;
MakeLineROI(XO,0,XO,height);
Fill;
for i:=l to rCount do begin

dxl:=pscale*0.5*rUser2[i]*cos(rUserl[i]*PI/180);
dyl:=pscale*0.5*rUser2[i]*sin(rUserl[i]*PI/180);
if i<rCount then begin

dx2:=pscale*0.5*rUser2[i+l]*cos(rUserl[i+l]*PI/180);
dy2:=pscale*0.5*rUser2[i+l]*sin(rUserl[i+1]*PI/180);

end else begin
dx2:=-pscale*0.5*rUser2[1]*cos(rUserl[1]*PI/180) ;
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dy2:=-pscale*0.5*rUser2[1]*sin(rUserl[l]*PI/180);
end;
MoveTo(XO+dxl,YO+dyl);
LineTo(XO+dx2,YO+dy2);
MoveTo(XO-dxl,YO-dyl);
LineTo(XO-dx2,YO-dy2);

end;
n:=rCount;
sumX:=0;
sumY:=0;
sumZ:=0;
sumXY:=0;
sumYZ:=0;
sumXZ:=0;
sumZsqr:=0;
sumXsqr:=0;
for i:=1 to n do begin

Y:=1/(sqr(rUser2[i]/2));
X:=cos(2*PI*rUserl[i]/180);
Z:=sin(2*PI*rUserl[i]/180);
sumX:=sumX+X;
sumY:=sumY+Y;
sumZ:=sumZ+Z;
sumXY:=sumXY+(X*Y);
sumYZ:=sumYZ+(Y*Z);
sumXZ:=sumXZ+(X*Z);
sumZsqr:=sumZsqr+sqr(Z);
sumXsqr:=sumXsqr+sqr(X);

end;
Cl:=((sumXY*sumZsqr)-(sumXZ*sumYZ))/((sumXsqr*sumZsqr)-sqr(sumXZ));
C2:=((sumYZ*sumXsqr)-(sumXY*sumXZ))/((sumXsqr*sumZsqr)-sqr(sumXZ));
CO:=(sumY/n) -Cl* (sumX/n)-C2* (sumZ/n);
for i:=l to rCount do begin

Thetal:=rUserl[i]*PI/180;
if i<rCount then Theta2:=rUserl[i+l]*PI/180
else Theta2:=rUserl[1]*PI/180;

L1:=1/sqrt(CO+C1*cos(2*Thetal)+C2*sin(2*Thetal));
L2:=1/sqrt(CO+Cl*cos(2*Theta2)+C2*sin(2*Theta2));
dxl:=pscale*L1*cos(Thetal);
dyl:=pscale*L1l*sin(Thetal);
if i<rCount then begin

dx2:=pscale*L2*cos(Theta2);
dy2:=pscale*L2*sin(Theta2);

end else begin
dx2:=-pscale*L2*cos(Theta2);
dy2:=-pscale*L2*sin(Theta2);

end;
MoveTo(XO+dxl,YO+dyl);
LineTo(XO+dx2,YO+dy2);
MoveTo(XO-dxl,YO-dyl);
LineTo(XO-dx2,YO-dy2);

end;
NewTextWindow('Results');
write('C0 = ',CO:8:8);
write('C1 = ',Cl:8:8);
write('C2 = ',C2:8:8);
end;
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macro 'Count Black and White Pixels [B]';

{
Counts the number of black and white pixels in the current

selection and stores the counts in the Userl and User2 columns.

}
begin

RequiresVersion (. 44);
SetUserlLabel('Black');
SetUser2Label('White');
Measure;
rUserl[rCount]:=histogram[255];
rUser2[rCount]:=histogram[0];
UpdateResults;

end;

macro 'Compute Percent Black and White';

{
Computes the percentage of back and white pixels in the

current selection. This macro only works with binary images.

}
var

nPixels,mean,mode,min,max:real;
begin

RequiresVersion (. 44);

SetUserlLabel('Black');
SetUser2Label('White');
Measure;
GetResults(nPixels,mean,mode,min,max);
rUserl[rCount]:=histogram[255]/nPixels;
rUser2[rCount]:=histogram[0]/nPixels;
UpdateResults;
if (histogram[O]+histogram[255])<>nPixels

then PutMessage('This macro requires a binary image.');

end;

macro 'Compute Area Percentage [P]';

{
Computes the percentage of foreground

pixels in the current selection.

var
mean,mode,min,max: real;
i, lower, upper, fPixels,nPixels,count:integer;

begin
RequiresVersion (. 50);
SetUserlLabel('%');
Measure;
GetResults(nPixels,mean,mode,min,max);
GetThresholds(lower,upper);
if (lower=0) and (upper=O) and

((histogram[0]+histogram[255])<>nPixels)
then begin

PutMessage('This macro requires a binary or thresholded image.');

111



exit;
end;

if nPixels=0 then begin
end;
if (lower=O) and (upper=O) then begin

if nPixels=0
then rUserl[rCount] :=O
else rUserl[rCount]:=(histogram[255]/nPixels)*100;

UpdateResults;
exit;

end;
fPixels:=0;
nPixels:=0;
for i:=0 to 255 do begin

count:=histogram[i];
nPixels:=nPixels+count;
if (i>=lower) and (i<=upper)
then fPixels:=fPixels+count;

end;
rUserl [rCount] :=(fPixels/nPixels)*100;
UpdateResults;

end;
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A.11 Tissue Digestion for ELISA and Immunoblotting Quantification
Amit Roy, 2008

SUPPLIES
* Tissue segments (stored in mini eppendorf tubes at -800C)
* 50mM Tris-HCl/150mM NaCI (pH7.5) (Boston BioProducts)
* .5M EDTA pH 8.0 (Cat. No. BM-150, Boston BioProducts)
* 200 U/mg Collagenase I (Cat. No. Ls 4196, Worthington)

EQUIPMENT
* Centrifuge
* Incubator

PROCEDURE

* Prepare digestion buffer cocktail:
o Per each segment to digest, prepare 50 gL of 50 mM Tris-HCL/150mM

NaCl/5mM EDTA/10 U Collagenase I
* Let tissue segments thaw at room temperature for 10 minutes.
* Add 50 [L of digestion buffer to each tissue segment.
* Incubate segments at 38'C for 8 hours.
* Aspirate any undigested tissue to break up mechanically. Centrifuge for 10 min at 8000

mmin .
* Save supernatant in new eppendorf tubes and store at -200 C until further use.

113



A.12 TGF pl Enzyme-Linked Immunosorbent Assay (ELISA)
adapted from R&D Systems MB 100B data sheet

SUPPLIES
* Digested tissue samples
* Mouse/Rat/Porcine/Canine TGF-beta 1 Quantikine ELISA Kit (Cat. No. MB 100B, R&D

Systems)
* Hydrochloric Acid HC1, lN (contained within Cat. No. MB100B, R&D Systems)
* Sodium Hydroxide NaOH, pellets (Cat. No. 7708, Mallinckrodt)

SOLUTIONS
* Sodium Hydroxide NaOH, IN: 10g NaOH in distilled water, final volume 250 mL

EQUIPMENT
* Microplate shaker (Cat. No. 12620-926, VWR)
* Microplate reader (SpectraMAX 340PC, Molecular Devices)

PROCEDURE

PREPARATION
* Dilute kit wash buffer and calibrator diluent to 1X.
* Reconstitute control.
* Prepare protein standards ranging from 31.2 pg/mL to 2000 pg/mL through six serial 1:2

dilutions.
o The standard curve will be later constructed using the known TGF p31

concentrations: 31.2 pg/mL, 62.5 pg/mL, 125 pg/mL, 250 pg/mL, 500 pg/mL,
1000 pg/mL, 2000 pg/mL

SAMPLE ACTIVATION AND DILUTION
* Aliquot 10 jgL of each digested tissue sample into an individual mini eppendorf tube.
* Add 4 tL of 1 N HC1 to each tube to activate any latent TGF P31. Lightly vortex the

samples. Let incubate at room temperature for 15 minutes.
* Neutralize samples by adding 4.2 [tL 1 N NaOH to each tube. Lightly vortex the

samples.
o Some reagents, such as distilled water, are slightly acidic. The volume of 1 N

NaOH needed to neutralize the sample was therefore greater than the volume of 1
N HCI added and was determined using litmus tests

* Dilute samples with 181.8 p.L of calibrator diluent. There should be enough volume in
each sample to run duplicates in the ELISA.

ELISA
* Remove excess microplate strips from the plate frame, return them to the foil pouch

containing the desiccant pack, and reseal.
* Add 50 [tL of assay diluent to each well.
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* Add 50 1tL of protein standard, control, blank or activated sample per well. Prepare wells
in duplicates. Tap the plate gently for one minute. Cover with the adhesive strip
provided. Incubate for 2 hours at room temperature while shaking.

* Aspirate each well and wash by filling each well with 400 9L wash buffer using a squirt
bottle. Complete removal of liquid at each step is essential to good

* performance. Wash 3x. After the last wash, remove any remaining Wash Buffer by
aspirating or decanting. Invert the plate and blot it against clean paper towels.

* Add 100 gtL of TGF-B 1 conjugate to each well. Cover with a new adhesive strip.
Incubate for 2 hours at room temperature while shaking.

* Repeat the aspiration/wash 3x.
* Add 100 gL of substrate solution to each well. Incubate for 30 minutes at room
* temperature. Protect from light.
* Add 100 jtL of stop solution to each well. Gently tap the plate to ensure thorough mixing.
* Determine the optical density of each well within 30 minutes, using a microplate reader

set to 450 nm. Set wavelength correction to 540 nm.
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A.13 Calculating ELISA Mass Protein per Mass Tissue Statistic

SOFTWARE
* SpectraMAX Pro Software
* Microsoft Excel

PROCEDURE
* Configure the SpectraMAX Pro software to produce the averaged duplicate readings for

each standard, control, and sample; the software will also subtract the average zero
standard optical density.

* Create a standard curve by generating a four parameter logistic (4-PL) curve-fit to the
data in the software. The program will determine the concentration of the diluted sample
by reading off the concentration from the curve that corresponds to the measured optical
density reading.

* Export the data to an Excel spreadsheet and compile with sample mass and dilution
information.

* Apply the following equation to the sample data to determine x/m, the mass TGF 131 per
mass explanted tissue segment (ug/g):

x [x]Vf= - -.10 -3 ,
m Xv m

where x is the mass of TGF 31 present in the sample in ug, m is the mass of
the explanted tissue segment in g, [x] is the concentration of TGF p31 in the

segment as determined by ELISA in ug/mL, Vf is the final volume of the

diluted sample prior to insertion into the wells, and ,v is the volume fraction

of the aliquot taken from the digested sample. The 10-3 was used in unit
conversion to express the mass protein over mass tissue statistic in ug/g.
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A.14 Dot Blot Technique for Antibody Cross-Reactivity Assessment

SUPPLIES
* Protein positive and negative controls

o TGF p1 (Cat. No. 100-21, Peprotech)
o TGF 32 (Cat. No. 100-35B, Peprotech)
o TGF P3 (Cat. No. 100-36, Peprotech)
o BSA (Cat. No. 03116999001, Roche)

* Primary antibodies to test
o Anti-TGF P1 (Cat. No. ab 10517, Abcam; Cat. No. 500-M66, Peprotech)
o Anti-TGF P2 (Cat. No. MAB612, R&D Systems; Cat. Nos. sc-90 & sc-31610,

Santa Cruz Biotechnology)
o Anti-TGF P3 (Cat. No. MAB643, R&D Systems; Cat. Nos. sc-82, Santa Cruz

Biotechnology)
* HRP-conjugated secondary antibodies

o Goat Anti-mouse (Cat. No. 31340, Thermo Fisher Scientific)
o Goat Anti-rabbit (Cat. No. 31460, Thermo Fisher Scientific)
o Rabbit Anti-goat (Cat. No. 31402, Thermo Fisher Scientific)

* .05% Tween-20 in Tris-buffered Saline (TBS), 10X (Cat. No. IBB-181-1L, Boston
BioProducts)

* Instant dry non-fat milk (Carnation)
* Methanol (Cat. No. 3016-16, Mallinckrodt)
* Immobilon PVDF membrane (Cat. No. IPSN07852, Millipore)
* SuperSignal West Femto Chemiluminescent Substrate (Cat. No. 34095, Thermo Fisher

Scientific)

SOLUTIONS
* Non-fat milk blocking buffer, 5% (%w/v): .5g instant dry non-fat milk in TBS; final

volume of 100mL
* Wash buffer: 100 mL of .05% Tween-20 in TBS (10X) in 900 mL distilled water
* Antibody diluent: .33g BSA in wash buffer, LX; final volume of 100 mL

EQUIPMENT
* Rotator
* Shaker
* Camera apparatus and Alpha Innotech FluorChem8900 image acquisition software

DOT BLOT
* Cut the Immobilon membrane into approximately 10mm x 40mm strips using a razor and

straight edge. Cut the upper right comer to denote orientation. Make one strip per each
antibody tested. Use a special lab marker or pen to denote the locations of the protein
spots and to label the strips for the antibody to be used. Wet the strips in methanol for 15
seconds. Rinse with distilled water.
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* Using a 1 gL pipet, spot the protein positive and negative controls onto each strip in a
straight line. Let the spots soak into the strip and air dry.

* After the strips are dry, let them rock in non-fat milk blocking buffer for 1 hour.
* Use the diluent to make the appropriate dilution of primary antibody, e.g. 1:500 for

monoclonals, 1:800 for polyclonals.
* Put each strip into a 5 mL test tube with the diluted primary antibody solution added to

the container. Rotate the tube in the diluted primary antibody solution for 1 hour at room
temperature.

* Fill new 5 mL tubes with the wash buffer and dip the strips 10-15x. Empty the tubes,
refill with new wash buffer, and dip the strips an additional 10-15x. Repeat the last step
for a total of 3 washes.

* Prepare the diluted secondary antibody solution using the antibody diluent. For example,
a 1:2000 dilution of goat anti-mouse IgG (H+L), peroxidase conjugated is recommended.
Incubate the membrane in a 5 mL test tube with diluted secondary antibody solution for 1
hour at room temperature.

* Fill new 5 mL tubes with the wash buffer and dip the strips 10-15x. Empty the tubes,
refill with new wash buffer, and dip the strips an additional 10-15x. Repeat the last step
for a total of 3 washes.

* Transfer the system to the Dedon Lab (500 Tech Sq) for imaging. Be sure to bring the
luminol and enhancer solution, a Falcon tube, aluminum foil, and clear sheet protector in
a chilled Styrofoam box.

* Combine .5 mL of the luminol solution with .5 mL of the enhancing solution.
* Incubate all membrane strips in the mixed luminol-enhancer solution for 5 minutes while

covered. Shake at room temperature.
* Put all strips in between two slices of a cut sheet protector. Place on top of a clear Petri

dish. Remove as many air bubbles as possible with a Kim wipe.

IMAGING
* Place the sheet protector-blot sandwich into the Alpha Innotech FluorChem 8900.
* Make sure the iris is fully open, and zoom all the way in on a subject. Adjust the focus.

Zoom out to see the whole membrane.
* Close the bottom door of the FluorChem 8900, but leave the top door open. Leave at

position 1 (no filter).
* Open up the FluorChem 8900 software. Choose the highest resolution and chemidisplay.

Test a few exposure times (1, 3 minutes). Put the warning sign on the bottom door so
that no one will open it while the camera is operating.
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A.15 Immunoblot Detection of Protein in Tissue Samples
adapted from S. Gallagher, D. Tzeranis

SUPPLIES
* Protein samples

o Digested tissue samples (Appendix A.11)
o Note: during the first run test a control, e.g. human smooth muscle extract

* Laemmli's reducing SDS Buffer 4X (Cat. No. BP-11 OR, Boston BioProducts)
* Glycerol (Cat. No. 16374, usb)
* Sodium Hydroxide (Cat. No. 7708, Mallinckrodt)
* Ready Gel Tris-HCI gel, 4-15%, 15-well 15 pL (Cat. No. 161-1122, Bio-Rad

Laboratories)
* Tris-Glycine-SDS Running Buffer 10X (Cat. No. BP-150, Boston BioProducts).
* Precision Plus All Blue standards (Cat. No. 161-0373, Bio-Rad Laboratories).
* Primary antibody for antigen of interest

o E.g. a-SMA monoclonal Ab (mouse IgG2a) (Cat. No. 2547-2ML, Sigma)
* HRP-conjugated secondary antibody

o Goat Anti-mouse (Cat. No. 31340, Thermo Fisher Scientific)
* Transfer buffer, 10X (Cat. No., BP-100, Boston BioProducts)
* .05% Tween-20 in Tris-buffered Saline (TBS), 10X (Cat. No. IBB-181-1L, Boston

BioProducts)
* Instant dry non-fat milk (Carnation)
* Methanol (Cat. No. 3016-16, Mallinckrodt)
* Immobilon PVDF membrane (Cat. No. IPSN07852, Millipore)
* SuperSignal West Femto Chemiluminescent Substrate (Cat. No. 34095, Thermo Fisher

Scientific)

SOLUTIONS
* Sample loading buffer (2X): 5 mL Laemmli's SDS buffer (4X), 4 mL distilled water, 1

mL glycerol
* 1N Sodium hydroxide: 10Og NaOH in distilled water, final volume 250 mL
* Running buffer: 100 mL Tris-Glycine-SDS running buffer (10X), 900 mL distilled water
* Transfer buffer: 100 mL Transfer buffer (10X), 900 mL distilled water

EQUIPMENT
* Mini Protean Tetra Cell for Ready Gel Precast Gels and Mini Trans-Blot Module (Cat.

No. 165-8030, Bio-Rad Laboratories)
* Dry Bath Incubator (Fisher Scientific)
* Power Source (300 V, VWR)
* Magnetic Stirrer
* Rocker
* Camera apparatus and Alpha Innotech FluorChem8900 image acquisition software
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PROCEDURE

PREPARATION
* Rinse the Mini-PROTEAN Tetra cell with de-ionized water.
* Turn on the dry heating block and set the temperature at 950C.

GEL POSITIONING
* Using a razor, score neatly (from right to left) the topmost edge of the black line located

on the ready gel. Remove slowly and carefully the sticker underneath the line (from left
to right) using the pull tab.

* Place the ready gel in the electrophoresis cell so that the smaller plastic plate faces the
inner side of the electrophoresis cell. Secure the gel using the two handles.

o Use the cell that contains two electric plugs on the top, if 1 or 2 gels will be run.
Use the second cell (doesn't contain plugs) if more than 2 gels will be run.

o When running 1 or 3 ready gels, use the provided buffer dams to cover the extra
empty spot of the cell.

* Place the cell-ready gel-dam assembly inside the tank.
o Make sure that red/black plugs are on the red/black marked sides of the tank.

* The space between two gels or between a gel and a dam forms an inner well. Add
running buffer in the inner well until the gel wells are fully covered.

* Add running buffer to the tank (outside of the assembly) up to the level indicated for
running 1-2 or 3-4 gels.

SAMPLE PREPARATION
* Prepare the samples inside clean .5 mL eppendorf tubes. Use one tube per sample. Dilute

4x with distilled water.
* In a new eppendorf tube, take 1 part of the 1:4 diluted sample and add 1 part of sample

loading buffer.
o Check and correct if necessary the pH of the samples using drops of lN NaOH.

The color of the samples should be dark blue (same as the Laemmli buffer).
* Store the 1:8 diluted samples at 4 deg until use.

LOAD THE GEL
* Heat the electrophoresis protein samples in the heat block (95 deg) for 5 minutes.
* Let the electrophoresis protein samples cool for 10 minutes.
* Micro-centrifuge the electrophoresis protein samples for 1 minute.
* Use a thin tipped pipette to load each electrophoresis protein sample (max 15 [tL) inside a

well of the ready gel.
* Load 7 ptL protein standard to one or two gel wells.

START ELECTROPHORESIS
* Place the lid of the assembly on top on the tank-cells.
* Connect the electrodes to the power supply using the cables.
* Turn on the power supply and select the applied voltage and electrophoresis time.
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* The gels run within approximately 6h when 35V is applied.

BLOT TRANSFER PREPARATION
* 1 hour before the electrophoresis will finish, begin soaking the transfer cassette, filter

paper, and fiber pads (Mini Trans-Blot Cell) in transfer buffer for 1 hour in a large
rectangular container (e.g. clean Rubbermaid container). Remove any air bubbles in the
fiber pads.

* 15 minutes before the electrophoresis will finish, pre-wet the Immobilon membrane in
methanol for 15 seconds. Wash with distilled water, and let sit in transfer buffer.

FINISH ELECTROPHORESIS
* After the gel has finished running, drain the running buffer (it can be disposed in the

sink) or store it at 4 deg so that it can be re-used (up to 3 times total).
* Unsecure the handles and remove the ready gels from the electrophoresis cell.
* Remove the sticker that connects two plastic covers. Gently separate the two plastic

covers, carefully using a razor if necessary. The polyacrylamide gel will remain attached
to one of the two plastic covers.

BLOT TRANSFER
* Assemble the blotting sandwich. Place one pre-wetted fiber pad on top of the black side

of the open cassette. Add a sheet of filter paper. Carefully add the gel, and remove any
air bubbles. Place the membrane on top of the gel. Note that the membrane is cut
smaller than the gel, so make sure it covers the appropriate area. Place another sheet of
filter paper on top, followed by a second fiber pad. Close the cassette firmly while
keeping the contents stable. Place the blotting sandwich in the transfer module, with the
black side of the cassette facing the black plate of the module.

* Fill the tank with some transfer buffer. Place the module in the tank. Add a standard stir
bar to help maintain even temperature and ion distribution. Completely fill the rest of the
tank with transfer buffer.

* Put on the tank lid and move stirring and tank assembly to 40 C fridge. Set the stirrer on a
very fast speed (speed setting 8). Plug the transfer cell cables into the power supply
(should be outside of the fridge) and run the blot at constant current (25 mA).

o Previously determine the optimal running time of transfer (3 hours TGF J3, 5
hours a SMA), by running gels in different transfer times and performing the rest
of the immunoblot protocol for strongest signal

* Turn off the power supply after optimal running time has passed. Disassemble the
blotting sandwich in a rectangular container with transfer buffer and carefully remove the
membrane. Place the membrane in a small container with enough 5% nonfat milk in TBS
blocking buffer to immerse the membrane.

* Clean the transfer cell, fiber pads, and cassettes being sure to rinse well with deionized
water.

IMMUNOBLOT DETECTION
* Let the membrane rock in the blocking buffer for 1 hour at room temperature.
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* Use antibody diluent to make the appropriate dilution of primary antibody. For example,
dilute the a-SMA primary antibody 1:1000 with the diluent (1.5 mL). Ensure
homogeneity of solution with end to end shaking.

* After the membrane is satisfactorily blocked, rinse the membrane in a small amount (1
mL) of antibody diluent. Empty the rinse. Then add the diluted primary antibody
solution to the container. Let the membrane rock in the diluted primary antibody solution
for 1 hour at room temperature.

* Add in approximately 5 mL of wash buffer into the small container with the membrane.
Let shake for 5 minutes at room temperature. Empty the container of the wash buffer and
wash again repeatedly for a total of 6 washes.

* Dilute the secondary antibody using the antibody diluent. For example, a 1:5000 dilution
of goat anti-mouse IgG (H+L), peroxidase conjugated is recommended. Incubate the
membrane in 2.5 mL of diluted secondary antibody solution for 1 hour at room
temperature.

* Wash the membrane 6 times for 5 minutes each.
* Transfer the system to the Dedon Lab (500 Tech Sq) for imaging. Be sure to bring the

luminol and enhancer solution, a Falcon tube, aluminum foil, and clear sheet protector in
a chilled Styrofoam box.

* Combine .5 mL of the luminol solution with .5 mL of the enhancing solution.
* Incubate the membrane in the mixed luminol-enhancer solution for 5 minutes while

covered. Shake at room temperature.
* Remove the membrane and put in between two slices of a cut sheet protector. Place on

top of a clear Petri dish. Remove as many air bubbles as possible with a Kim wipe.

IMAGING
* Place the sheet protector-blot sandwich into the Alpha Innotech FluorChem 8900.
* Make sure the iris is fully open, and zoom all the way in on a subject. Adjust the focus.

Zoom out to see the whole membrane.
* Close the bottom door of the FluorChem 8900, but leave the top door open. Leave at

position 1 (no filter).
* Open up the FluorChem 8900 software. Choose the highest resolution and chemidisplay.

Pick the appropriate exposure time (1, 3, 10 minutes). Put the warning sign on the
bottom door so that no one will open it while the camera is operating.

* Perform image processing as needed. Make sure all images that are meant to be
compared are taken at the same exposure time with the same black, white, and gamma
properties.
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A.16 Semiquantification of Immunoblot Bands

SOFTWARE
* AlphaEase FC
* Microsoft Excel

PROCEDURE
* Open image to be analyzed in AlphaEase FC software. Go to Toolbox window and click

on Analysis Tools tab. Then click on Spot denso.
* Using the rectangle tool under object, draw a border around the protein bands of interest.

Do not draw too large or too small of a band; some background should be included.
* Click on auto bkgd. This calculates the average of the 10 lowest pixel values in the

rectangle and subtracts it from each pixel value in the integrated density value (IDV) to
be calculated.

* Output the area, IDV, avg (IDV/area), and bkgd data to a txt file. Open up this file in
Excel and compile for all segment samples.

o In this study, the avg statistic was used to compare relative protein concentration.
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A.17 Direct Immunofluorescence Measurement of Protein in Formalin Fixed, Paraffin-
Embedded Tissue

adapted from P. Castellazzi, E. Ueda (2008), A. Alexander

SUPPLIES
* Xylene (Histoprep)
* Ethyl alcohol, 200 proof (Histoprep)
* Antigen Unmasking Solution (Cat. No. H-3300, Vector)
* Antibody Diluent (Cat. No. S0809, Dako)
* PAP pen (Cat. No. Z377821, Sigma)
* Phosphate Buffered Saline (PBS) (Cat. No. P3813, Sigma)
* Fluorophore-conjugated primary antibody

o Monoclonal aSMA-Cy3 (Cat. No. C6198, Sigma)
* 4',6-diamidino-2-phenylindole (DAPI), dihydrochloride (Cat. No. D1306, Invitrogen)
* Shandon Immu-Mount (Cat. No. 9990402, Fisher Scientific)
* Wheaton Glass Staining Dish (Cat. No. 08-811, Fisher Scientific)
* 10 (20 back-to-back) glass slide rack

SOLUTIONS
* Ethanol 80%, 95%
* Antigen retrieval buffer: 2 mL antigen unmasking solution, 212 mL distilled water

o Store unused buffer at 40C

EQUIPMENT
* Microwave
* Centrifuge
* Humid chamber: Tupperware container lined inside with wet paper towels, filled with as

many upside down empty pipette containers that can fit inside the container (for slides to
rest on), and covered with a lid. Wrap the outside of the container (if clear) with
aluminum foil to protect slides from light.

PROCEDURE

PREPARATION
* For slides to be stained, let bake on slide dryer for at least an additional hour before

deparaffinizing.

IMMUNOFLUORESCENT LABELING
* Deparaffinize and rehydrate paraffin-embedded sections:

o Xylene (or substitute) 2 x 5 min
o 100% alcohol 2 x 3 min
o 95% alcohol 2 x 2 min
o 80% alcohol 1 min
o Wash in running tap water 5 min
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* Heat Induced Epitope Retrieval:
o Pour -150 mL antigen retrieval buffer in staining dish. Put in glass slide rack and

cover with glass lid. Pre-heat the setup for 1 minute in the microwave on power
setting 1.

o Uncover the staining dish. Place slides into rack immersed in warmed antigen
retrieval buffer. Return glass lid on dish and microwave setup for 10 minutes on
power setting 1.

o Let cool, uncovered, at room temperature for 20 minutes.
* Wash slides with PBS for 3 x 5 min at room temperature.
* Remove the slides from the PBS but pipet a small but sufficient amount (10-20 pL) of

PBS onto the samples as to keep them from drying. Use the hydrophobic PAP pen to
draw circles around each sample to reduce the amount of reagent needed.

* Whenever handling fluorophore-conjugated antibody, work in a dim setting. Dilute a
SMA-Cy3 antibody 1:100 in antibody diluent. Centrifuge for 2 minutes at 10000 min - .
Pipet -20 ptL of the diluted antibody onto each sample and let incubate overnight at 40 C
in a humid chamber.

* Wash slides with PBS for 3 x 5 min at room temperature.
* Pipet 200 ng/ml DAPI diluted in distilled water (-30 pL) onto each sample for 10 min at

room temperature.
* Wash slides with PBS at room temperature for 3 x 5 min.
* Cover the samples with Immu-Mount and coverslip.
* Let dry for an hour before handling.

IMAGING
* Bring slides to Olympus BX60 microscope (VA Medical Center, R1-118). Turn on the

computer, monitor, and mercury lamp.
* Locate the tissue with the lowest magnification objective by using the UV filter to find

and focus on the DAPI-stained nuclei. If the section is intact (no missing pieces, not
cracked, not folded onto itself) and clean (no air bubbles from mounting medium, no
debris), continue with protocol. Else pan around the slide for the duplicate or triplicate
section.

* Turn on the appropriate filter for the fluorophore used (e.g. Rhodamine filter for Cy3).
* Open the DP Controller program on the computer. Pull out the knob on the microscope

eyepiece to allow light only to be passed through to the camera. Adjust the focus so that
it looks correct on the computer screen.

* With the settings of ISO800 and image size 680x512, capture the image under 333 ms
exposure with 10X objective or 100 ms exposure with 20X objective. This step is
particular to the amount of protein present in the sample, the antibody concentrations,
incubation conditions, and the properties of the fluorophore. Repeat until entire region of
interest is captured.

o If cell information is important, repeat image capture using 25 ms (10X objective)
or 10 ms (20X objective) with UV filter set.

SLIDE STORAGE
* Keep slides lying flat in a microscope slide folder at 40 C. If necessary, cover the slide

folder in aluminum foil to protect slides from light.
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A.18 Determining Immunoblot Correction Factor for a SMA Using Immunofluorescence
Data

SOFTWARE
* Adobe Photoshop
* ImageJ
* Microsoft Excel

PROCEDURE
This procedure was used for a correction factor in the a SMA immunoblot data, which due to the
limitations of sampling collagen tube treated segments, included expression from external scar
on the outside surface of the collagen tube. Silicone treated segments were removed from the
tube prior to tissue digestion, and so a SMA correction was not used.

Note: one should be careful in using scaling factors for a SMA and cellular content determined
by immunofluorescence sections (2D) for immunoblot samples (3D), especially if the scaling
factors are a function of location within the nerve. The most accurate scaling factor should be
developed by repeating this procedure from as many locations within the nerve as possible.

PHOTO STITCHING
* Open 10X images for a SMA-cy3 fluorescent nerve in Adobe Photoshop. Align and

merge images until nerve cross section is complete. Clean up any debris that exists
outside of the cross section using the black paintbrush tool.

* Repeat steps using 10X images for DAPI fluorescence.

a SMA CORRECTION FACTOR
* Open image of a SMA fluorescent, complete nerve cross section in Image J. Set the

scale under Analyze>Set Scale...
o With the image capture settings of 680x512 using the Olympus BX60 microscope

(VA Medical Center, RI-118), the scale is defined at 156 px = 200 gm
o Make this setting global if continuing to work with multiple nerve cross section

images
* Add an additional measurement by going to Analyze>Set Measurements... and click on

Integrated Density.
* Go to Edit>Invert and Image>Type>8-bit to convert the image for analysis.
* Under Image>Adjust>Threshold, determine a threshold that defines positive staining.
* Select the positively stained areas by going to Edit>Selection>Create Selection.
* Run Analyze>Measure to determine the area and integrated density of the entire

fluorescence in the image.
* Using the polygon selections tool, define a border around the internal nerve regenerate

(you may have to remove the threshold first, draw the border, and then restore the
threshold). Run Analyze>Measure to determine the area and integrated density of the
fluorescence coming internally.

* Open Excel and compile the area and integrated density measurements contributed by the
total nerve cross section and by the internal regenerate. Determine the percent expression
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from the regenerate by dividing the integrated density of the internal over the integrated
density of the total section (percent integrated density is more accurate than percent area).
It may be useful to determine the percent expression external to the regenerate (1-percent
expression from internal)

* Arrange data according to location of cross section along the length of the explant.
* Per each location, generate mean percent expression from regenerate ± SEM data. If

statistically okay to combine all measurements regardless of location in explant, then do
so as a first order approximation.

* Use mean percent as a coefficient in a SMA immunoblot data.

CELLULAR CONTENT CORRECTION FACTOR
* Open image of DAPI stained, complete nerve cross section in Image J.
* Go to Edit>Invert and Image>Type>8-bit to convert the image for analysis.
* Under Image>Adjust>Threshold, determine a threshold that defines positive staining.
* Run Analyze>Analyze Particles. In the summary locate the number of particles

analyzed, which should be the total number of nuclei in the entire cross section.
* Using the polygon selections tool, define a border around the internal nerve regenerate

(you may have to remove the threshold first, draw the border, and then restore the
threshold). Run Analyze>Analyze Particles to determine the number of nuclei from the
regenerate.

* Open Excel and compile number of particle measurements contributed by the total nerve
cross section and by the internal regenerate. Determine the cellular percent from the
regenerate by dividing the number of particles from the internal region of interest over
the number of particles from the total section.

* Arrange data according to location of cross section along the length of the explant.
* Per each location, generate mean cellular percent from regenerate ± SEM data. If

statistically okay to combine all measurements regardless of location in explant, then do
so as a first order approximation.

* Use mean cellular percent as a coefficient in a Tubulin immunoblot data.
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A.19 Quantifying a SMA Fluorescence Intensity Using Concentric Shell Sampling Specified
by Radial Distance from Edge

SOFTWARE
* ImageJ
* Microsoft Excel

PROCEDURE
* Open image to be analyzed in ImageJ. Go to Plugins>Macros>Run and select

EdgeIntensity.txt (code to follow). If running this macro repeatedly, you may find it
convenient to make Edge Intensity a shortcut by editing the Plugins>Macros>About
Startup Macros... file.

* A window should appear asking for the scale measurements (as determined by the
microscope-camera capture settings), sampling information (how many pixels apart
should each sample be, and for how many pixels away from the edge should the program
run), and sample orientation (whole nerve cross section, or top left, top right, bottom left,
or bottom right portion of the nerve cross section). Enter the information specific to the
picture being analyzed.

o Note the code currently works for whole nerve cross sections and bottom right
sections. Cross sections of the other orientations are flipped until they seem like
bottom right cross sections.

* Once the information has been entered, a region of interest (ROI) must be determined by
the user. This region is the part of the image from where the program will sample the
intensity. Select the region of interest with a selection tool or just use the whole image by
selecting all (Ctrl A). Go to Edit>Selection>Create Mask. At this point the program will
generate a series of images with the Red, Green, and Blue channel intensities from your
original image.

* At this point, an edge must be defined. In collagen treated nerve cross sections, the edge
is the boundary between the collagen tube and the nerve regenerate. In silicone treated
nerve cross sections, the edge is between the negative space (black) and the nerve
regenerate.

o If using a portion rather than the whole nerve cross section, be careful to define
the leftmost and topmost edges at the leftmost and topmost boundary of the
image.

o If the edge is difficult to see, open up the corresponding DAPI image (and if
necessary, flip the image to seem as bottom right orientation of nerve tube).
Select the edge using the polygons selection tool, save the selection as a ROI (Ctrl
T, then save in the ROI Manager), and close the DAPI image. Return to the RGB
image and click on the ROI generated in the manager. Create a mask by going to
Edit>Selection>Create Mask.

* The program will run on its own, sampling the image as user specified. When finished,
the results window will contain the average intensities for the Red (Channel 0), Green
(Channel 1), and Blue (Channel 2) channels as a function of distance away from the edge.
Copy and paste this information in Excel.
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* In Excel, delete the intensities corresponding to Channel 1 and Channel 2. Only the Red
channel is of interest due to the emission spectrum of cy3. Plot the intensities as a
function of distance from the edge.

* As a statistic for comparing intensities between different cross sections, sum the average
red intensity from the edge to a certain distance away.

ASSOCIATED CODE
Code contained inside Edgelntensity.txt

// Modified from "EdgeRatio" code by Liang Cai
// Adapted by Kathy Miu

//
// Analysis of immunofluorescent staining
// as a function as distance from edge
// (whole nerve or portions of cross section)

//
// For RGB tif file
//
// measure R G B channel presented by 0 1 2
// ratio Blue to Green, presented by 4
// ratio Blue to Red, presented by 5
// ratio Green to Red, presented by 6
//

macro "MeasureEdge-RGB" {
requires ("1.34m");
run("Clear Results");

title = getTitle();

// inputs for the macro
steppix = 5; // expand or shrink per px during the measure
distance = 100; // total +/- distance from the edge, in px
orientation = 0; // default picture contains whole nerve

// scaling: how many pixels per pm?
// default px/um using 10X mag and Olympus BX60 setup (VA Med Ctr, R1-118)

pxscale = 156;
umscale = 200;

Dialog.create("How to measure the edge");
Dialog.addMessage("To measure the edge of a cell:");
Dialog.addMessage(" 1. select the region you want to analyze and create

a mask");
Dialog.addMessage(" 2. use threshold and wand tool to outline the cell

and create another mask");
Dialog.addMessage(" 3. use the excel to graph the result");

Dialog.addMessage("How many pixels per pm?");

Dialog.addNumber("Number of pixels:", pxscale);

Dialog.addNumber("per how many pm:", umscale);

Dialog.addMessage("Configure the program:");

Dialog.addNumber("Number of px per step:", steppix);
Dialog.addNumber("Distance to measure in px:", distance);
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Dialog.addNumber("Nerve section (0=whole,l=top left,2=top
right,3=bottom left,4=bottom right):", orientation);

Dialog.show();
pxscale = Dialog.getNumber();
umscale = Dialog.getNumber();
steppix = Dialog.getNumber();
distance = Dialog.getNumber();
orientation = Dialog.getNumber();

if ((distance % steppix) > 0) {
exit("Remainder must be 0!");

if (orientation == 0) {}
else if (orientation == 1) {

run("Flip Horizontally");
run("Flip Vertically"); }

else if (orientation == 2) {
run("Flip Vertically"); }

else if (orientation == 3) {
run("Flip Horizontally") ;

else if (orientation == 4) {}
else

}
exit("Wrong input for nerve section type");

// initiate array
realpair = distance / steppix;

// counts = realpair * 2 + 1;
counts = realpair + 1;

// realpair + 1 + 4 + one more
RealCount = minOf((realpair + 7),counts);

selectWindow(title);
RGB = newArray("red", "green",
yMin = newArray(255,255,255);
yMax = newArray(0,0,0);

"blue") ;

// create data from shrinked/expanded mask, smaller to bigger, do 3 times for
RGB
// run("Create Mask"); use other way to get Mask!!

selectWindow(title);
run("RGB Split");
rename("blue");
wait(140);
run("Put Behind [tab]");
rename("green");
wait(140);
run("Put Behind [tab]");
rename("red");
wait(140);
run("Put Behind [tab]");

run("RGB Merge...", "red=red green=green blue=blue keep");
run("Enhance Contrast", "saturated=0.5");
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setTool(2);

stepone = 0;
while (isOpen("Mask")!=true && stepone == 0)

wait(1000);
showStatus("Please Make Mask for ROI First");

}
selectWindow("Mask");
rename("ROI-red");
run("Duplicate...", "title=ROI-green");
run("Duplicate...", "title=ROI-blue");
stepone = 1;

selectWindow("RGB");
run("8-bit");
run("Enhance Contrast", "saturated=0.5 normalize");

setTool(8);

while (isOpen("Mask")!=true && stepone == 1)
wait(1000);
showStatus("Please Make Mask First");

selectWindow("RGB");
close ();

i = 0;
while (i < RealCount)

selectWindow("Mask");
run("Duplicate...", "title=MaskRun");
if ((i - realpair) > 0) {

selectWindow("MaskRun");
run("Maximum...", "radius="+((i - realpair) * steppix));
selectWindow("MaskRun");
run("Duplicate...", "title=MaskErase");
selectWindow("MaskRun");
run("Outline");

else if ((i - realpair) == 0) {
selectWindow("MaskRun");
run("Duplicate...", "title=MaskErase");
selectWindow("MaskRun");
run("Outline");

else {
selectWindow("MaskRun");
run("Minimum...", "radius="+((realpair - i) * steppix));

selectWindow("MaskRun");
run("Duplicate...", "title=MaskErase");

selectWindow("MaskRun");
run("Outline");

if (orientation != 0){
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selectWindow("MaskErase");
run("Translate...", "x=-2 y=-2");
imageCalculator("Subtract", "MaskRun","MaskErase");
selectWindow("MaskRun");

rename ("MaskRun-red");
run("Duplicate...", "title=MaskRun-green");
run("Duplicate...", "title=MaskRun-blue");
selectWindow("MaskErase");
close ();

for(rgbcycle=0; rgbcycle<3; rgbcycle++) {
run("Image Calculator...", "imagel=MaskRun-

"+RGB[rgbcycle]+" operation=AND image2="+RGB[rgbcycle]);
run("Image Calculator...", "imagel=MaskRun-

"+RGB[rgbcycle]+" operation=AND image2=ROI-"+RGB[rgbcycle]);
setThreshold(l, 255);
run("Set Measurements...", "area standard mean limit

redirect=None decimal=2");
selectWindow("MaskRun-"+RGB[rgbcycle]);
run("Measure");

callSD = getResult("StdDev", (nResults - 1));
callN = getResult("Area", (nResults - 1));

SEM = callSD / sqrt(callN);

xValues = ((i - realpair) * steppix) * umscale / pxscale;

yValues = getResult("Mean", (nResults - 1));

yMin[rgbcycle] = minOf(yMin[rgbcycle], yValues);
yMax[rgbcycle] = maxOf(yMax[rgbcycle], yValues);

setResult("RGB-channel", (nResults - 1), rgbcycle);
setResult("Distance", (nResults - 1), xValues);
setResult("Intensity", (nResults - 1), yValues);
setResult("SemOfInt", (nResults - 1), SEM);

close ();

i ++;

updateResults ();

selectWindow("Mask");
close ();
selectWindow("ROI-red");
close ();
selectWindow("ROI-green");
close ();
selectWindow("ROI-blue");
close ();

run("RGB Merge...", "red=red green=green blue=blue");

// ratio Blue to Green, presented by 4
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// ratio Blue to Red, presented by 5
// ratio Green to Red, presented by 6

i = 0;

while (i < RealCount) {
for(j=0; j<3; j++)

setResult("PercInt", (i*3+j),
- yMin[j]) / (yMax[j] - yMin[jl)) );

setResult("PercSEM", (i*3+j),
(i*3+j)) / (yMax[j] - yMin[j])) );

setResult("b2g-Ratio", (i*3+j)
2)) / getResult("Mean", (i*3 + 1))) );

setResult("b2r-Ratio", (i*3+j)
2)) / getResult("Mean", (i*3))) );

setResult("g2r-Ratio", (i*3+j)
1)) / getResult("Mean", (i*3))) );

i ++;

updateResults();

selectWindow("RGB");
close ();

((getResult("Mean", (i*3+j))

(getResult ("SemOfInt",

, (getResult("Mean", (i*3 +

, (getResult("Mean", (i*3 +

, (getResult("Mean", (i*3 +
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